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1 TOPS Terminal

Chapter

6
Text Editing and Printing

TOPS Terminal has powerful editing and printing capabilities.  With TOPS Terminal you can do the following:

•  Edit a file on your Macintosh 
•  Edit a file on a remote computer 
•  Print all or part of a session transcript or editor document, or     print a number of files 

You can also log on to a remote computer and use an editor there or edit a file mounted as a local volume from a remote file server using TOPS 
networking software.  

This chapter explains how to use TOPS Terminal for local editing, remote editing, and printing — after a brief discussion of the tools TOPS Terminal 
provides.

Files You Can Edit with the TOPS Terminal Editor

You can use the TOPS Terminal editor to edit text files, including any plain text (ASCII) files, such as those created with editors such as emacs, vi, 
and ed .  It also includes files created by the TOPS Terminal editor (by selecting New in the File menu) and TOPS Terminal editor documents created 
by saving session transcripts.  

Generally, word processing documents cannot be edited with the TOPS Terminal editor — because of the computer-specific or application-specific 
formatting characters imbedded in the documents.  If you are running TOPS 
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2 TOPS Terminal
Terminal and you open a folder with such documents in it, the names of these files will not be displayed in the dialog window.  

But most word processors will allow you to save a document as “text only” or “text only with line feeds.”  If you want to edit a Microsoft Word 
document with the TOPS Terminal editor, for instance, you can save the document as “Text Only with Line Breaks” from within Word; the file can 
then be edited by TOPS Terminal.

Saving During an Editing Session

Just as you do for other text editing applications you should save periodically during an editing session, by selecting Save from the File menu.  This 
will prevent losing a lot of work if there is a power failure or other problem.  Note that if you attempt to close the edit session window by clicking on 
the close box, you will be warned if you have changed the file since the last Save, and be given an opportunity to save then.  

Editing Tools

Use the File, Edit, and Text menus during local or remote editing on TOPS Terminal, as explained below.  

Selecting Text

Select a word by double clicking with the mouse, select lines of text by sweeping down the left side of the edit window while holding the mouse 
button down, or select a block of text by sweeping across and down the text while holding the mouse button down or by selecting a word and then 
holding the Shift key down, moving the mouse, and pressing the mouse button.  

The File Menu - File Handling and Printing

The File menu is used for file handling and printing; printing is discussed later in this chapter.  
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3 TOPS Terminal

Use the File menu for the standard file handling functions:  open a new text file (New), open an existing text file (Open), close the current file 
(Close), save the current file (Save), save the current file with a new name (Save As), and specify margin and other page layout settings (Page 
Layout).

The File menu also has some special-purpose functions:

Revert To Saved
If you make a major error while editing, select Revert to Saved  to restore the file as it was the last time you saved it:  
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4 TOPS Terminal
You will be warned that all changes since the last save will be lost:  

Delete
You can delete the current file by selecting Delete; you will be warned before the file is deleted.  

The file be deleted and the edit session window will be closed if you click Yes.
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5 TOPS Terminal
Save Selection
Select Save Selection to save selected text into a new file.  You will be asked to name the file:  

 

When you type in a name and select Save, a new edit session window will be opened, the selected text will be written into the window, and the 
window will be closed.  If you type the name of a file that exists in the current folder, you will be warned that the old file will be replaced by the new 
one.

The Edit Menu - Cutting and Pasting

Use the Edit menu for the standard Macintosh Cut, Copy, and Paste commands in an editor document.  The TOPS Terminal Edit menu also has a 
Select All  option for selecting the entire document and Clear to delete selected text without affecting the contents of the Clipboard.
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6 TOPS Terminal

You can use these functions during a TOPS Terminal editing session, and you can also use them to save text from a remote computer during a 
terminal session.  For example, you can read your mail on a remote computer, select a message you want to save, select Copy to place the selected 
message in the Macintosh Clipboard, Open a file on your Macintosh, and Paste the contents of the Clipboard into the file.  Note that you cannot use 
Cut or Clear during a terminal session.  

The Text Menu - Finding and Replacing

The Text menu gives you the functions available in a standard Macintosh Search menu, plus a bit more:
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7 TOPS Terminal
Shift Left /Shift Right
Moves a line or lines of selected text one tab stop to the left and right, respectively.  Use this function to create indented paragraphs or blocks of text.

Jump to Selection or Jump to Insertion 
Scrolls the edit window to display selected text if the selection is not already in the window, or the vertical-line insertion point if no text is selected.

Find Selection
Finds the next instance of selected text in forward direction and selects the text when found.

Find Forward
Finds the next instance, in forward direction, of the text you type in the Find  Forward dialog window and selects the found text.

A note about find wrapping
One of the things you can change in the Your Preferences menu is Find Wrapping.  This determines whether find and replace functions will 
automatically wrap around the end of a file (if action is in forward direction) or around the front of a file (if action is in backward direction).  The 
default value is for finds and replaces to wrap around.  See Appendix B if you want to change the setting.

Case Sensitive Find or Replace
Normally find and replace ignore case:  “ABC” is the same as “abc.”  If you check the Case Sensitive box before doing a find or replace, however, 
find 
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8 TOPS Terminal
or replace will only find text that matches the text exactly.  

Searching for Entire Words
Normally find and replace look for any instance of the selected or typed text:  a search for “connect” will find both “connect” and “connection.”  If 
you check the Entire Word box before doing a find or replace, however, a search for “connect” will only find separate words that match the search 
string.  

Find Backward
Finds next instance, in backward direction, of the text you type in the Find Backward  dialog window and selects the found text.

Find Same
Depending on whether you most recently did a forward or backward find, finds next or previous instance, of text you previously typed in Find dialog 
window and selects the found text; this function does not display the Find dialog window.

Replace Forward
Starts replace dialog; in forward direction, finds the text you type in Replace Forward dialog window and replaces the found text.  Note that you can 
select Replace All to replace all instances of the text in one pass, you can find and replace the text one instance at a time with Find/Replace, or you 
can Find the text and Replace it on a case-by-case basis.  
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9 TOPS Terminal

Replace Backward
Starts replace dialog; in backward direction, finds the text you type in replace dialog window and replaces the found text, as you specify.

Repeat Replace
Repeats the Replace command, without displaying the Replace dialog window.  
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10 TOPS Terminal

Local Editing

Use the TOPS Terminal editor to edit TOPS Terminal and other plain text files on your Macintosh.  Note that if you double click on a TOPS 
Terminal editor document from the Macintosh Desktop, TOPS Terminal will start up and the selected file will be displayed in a TOPS Terminal 
editor window.  The instructions below are for using the editor once you are in TOPS Terminal.  

Create a New Editor Document

After starting up TOPS Terminal do the following to create a new editor document:

1. Select New in the File menu.

You will be asked what you want to name the new document:

2. Type a name for the file and click New.

A new TOPS Terminal editor window will be drawn.  The name of the file (“New file” in this case) will be displayed at the top of the 

.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

Text Editing and Printing 10



.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

11 TOPS Terminal
window and the words “Editor Document” will be shown in the status box at the lower-left of the window:

3. Type the new document.

Use the editing tools described earlier in this chapter to create a new editor document.

4. Select Save in File menu.

This will save the document under the name you gave it when you created it (“New file” in this example).

5. Click the close box.

If you have not just saved the file you will be warned that you have made changes to the file but have not saved them, and you will be given 
the option of saving or not saving the changes.  

6. Click Yes or No.  

Click Yes to save the changes since the last Save or No if you do not want to save the changes.  The editor window will be closed.
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12 TOPS Terminal

Edit an Existing Editor Document

After starting up TOPS Terminal do the following to edit an existing editor document:

1. Select Open in the File menu.

You will be given the opportunity to select a document to edit.  Select Open to open an existing document.  Only folders and plain text files 
will be listed:

2. Select a file and click Open.

A new TOPS Terminal editor window will be drawn and the file you selected will be displayed.  The name of the file will be displayed at 
the top of the window (“Manual Phone 2/24/88 0” in this example) and the words Editor Document will be shown in the status box at the 
lower-left of the window:
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13 TOPS Terminal

3. Edit the document.

Use the editing tools described earlier in this chapter to edit the document:  cut, copy, paste, delete, etc. — changing windows to work in 
other editor documents or terminal sessions.

4. Select Save in File menu.

This will save the document under the name it had when you opened it during this edit session.  You could select Save As if you want to 
save the document with a new name.  

5. Click the close box.

If you have not just saved the document you will be warned that you have made changes to the document but have not saved them, and you 
will be given the option of saving or not saving the changes.  
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14 TOPS Terminal
6. Click Yes or No.  

Click Yes to save the changes since the last Save or No if you do not want to save the changes.  The edit session window will be closed.

Remote Editing

There are four ways to edit a file residing on a remote computer: 

•  Use Edit File in the Network  menu
•  Copy a file to your Macintosh with Receive File and edit the file     locally with the TOPS Terminal editor
•  Log on to the remote computer and use an editor there 
•  Mount a volume with TOPS or another file server and edit the     file locally with the TOPS Terminal editor 

Edit File Command - Network Account

The Edit File command in the Network menu lets you edit text files residing on remote computers on your local area network.  Edit File is a 
combination of Receive File, local editing, and Send File:  the file is copied to your Macintosh where you edit it with the TOPS Terminal editor, and 
then automatically copied back to the remote computer when you save the file.  

To edit a file on a network computer for which you have created a TOPS Terminal account, do the following after starting TOPS Terminal:

1. Select File Session in the Network menu.

You will be asked to select an account:
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15 TOPS Terminal

2. Select account and click Connect.

A new session window will be drawn and an FTP file session will be started up.  If you have not included the password in the account 
description, you will be asked for the password before the connection is completed.  A list of the commands available during a file session is 
the last item in the window.  

Note that these commands are invoked using the Network or Network/Commands menu; you can't type commands during a file session.  

3. Select Edit File in the Network menu.
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16 TOPS Terminal

A dialog window (the same window as for Receive File) will be displayed, asking you to select the file you want to edit from a list of files 
on the remote computer.  There may be a brief delay while TOPS Terminal prepares to list the current directory contents.  

4. Change directories, if necessary.

The two columns under the Go To Parent box list the files and directories in the current directory on the remote computer (Suntops, a UNIX 
system, in this case).  Use the scroll bar to scroll up or down to find the directory or file you want.
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17 TOPS Terminal

To list the contents of a directory in the list, double click on it; a new list will be displayed.  To move up one level in the directory structure, 
click on Go To Parent.

Note to UNIX users:  directories and files look the same in the list.  If you think one of the entries is a directory, but you're not sure, 
double-click on the name; if it is a directory, the list of files in the directory will be displayed.  

5. Select the file you want to edit.

When you are in the right directory, select the file you want to edit.  Note that the name of the file is automatically inserted into the Name 
box on the right side of the dialog window.  Note also that Text is the only available Transfer Format.  

6. Change folders and file name (optional).

Select a different folder from the list on the right side of the dialog window, if you want the file copied to a folder other than the current one 
(“Tops Terminal” in the example above, “tops” below).  If you want the file to have a different name on your Macintosh, change or replace 
the name in the Name box.

7. Select Receive.

.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

Text Editing and Printing 17



.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

18 TOPS Terminal
The file on the other computer will be copied to your Macintosh.  Details about the transfer will be displayed in the file session window.  
The main thing you want to check for, as explained in the discussion of Send File - Network Account, is the message “Transfer Complete” 
(or a similar message).  

When the transfer is complete, an edit session window will be opened, displaying a copy of the file you selected from the list on the remote 
computer.

8. Edit the file.  

Use the File, Edit, and Text menus to edit the file, as described in “Editing Tools,” starting on page 112.

9. Save the file.

When you are finished editing the file, select Save in the File menu.  The file will be saved on the remote computer and on your Macintosh 
(see Note below).  

Note: the file will not be saved on your Macintosh if you changed the default setting for saving a local copy during remote editing (see 
Your Preferences in Appendix B).

10. Click the close box.

Click on the close box  at the top-left of the edit session window.  If you have not made any changes since saving the file, the edit session 
window will be closed, leaving the file session window active (unless you closed it earlier, or the connection to the remote computer was 
broken somehow.  See “Closing the File Session Window before Saving,” following step 13 below.)

(If you have not saved since making changes to the file, you will be told that you have made changes and be given a chance to save the 
changes.  Click Yes to save the changes on the remote computer, or No if you do not wish to save the changes.  If you click Yes, TOPS 
Terminal will complete the editing process by updating the file on the remote computer and on your Macintosh, unless you changed the 
default setting, as discussed in step 9 above).  

11. Edit another file, if you wish.
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19 TOPS Terminal
Open another edit session window to edit another file on the same remote computer by selecting Edit File, if you wish.  Repeat steps 3 to 10 
above.

12. Select Goodbye from the Commands menu.

This is equivalent to logging off from a terminal session; since you can't type during file sessions, you have to use menus.  Alternatively, 
you could hold down the Option and Clover ( ) ⌘ keys and press the letter Y, which is the keyboard equivalent for Goodbye.   

13. Close the window.

Click on the close box at the top-left of the window to close the window.  

Note: if you click on the close box before selecting Goodbye you will be asked if you really want to terminate the connection.  Do not do 
this unless you have good reason to believe there is a serious problem with the session, such as the remote computer crashing.  

Closing the File Session Window before Saving

If you close the file session window (or if the connection is broken, somehow) before saving the file during a remote edit, the connection to 
the remote computer is lost and you are now performing a local edit on the file that was copied from the remote computer.  If you make 
changes to the file and save them, the file will be saved on your Macintosh, but not to the remote computer.  You will see the following 
message:  
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You can still save the file on the remote computer, if you wish:  start up a new file session, select the same account as before, switch to the 
edit session window, and click Save.  The file will be saved on the remote computer.

Remote Editing - Phone Account

Because file transfer service is not available on phone accounts, it is not practical to use Edit File for remote editing on such accounts.  To edit a text 
file on a computer you reach on a phone connection, copy the file to your Macintosh as explained in Chapter 5 (Receive File), edit it locally, as 
explained above, and then copy it back to the remote computer (Send File).  

Or you might want to log on to the remote computer and edit it with an editor such as emacs, vi, or ed; this method is described below.  

Using an Editor on a Remote Computer

This method of editing takes advantage of the terminal emulation capabilities of TOPS Terminal.  Once you are connected to a remote computer with 
TOPS Terminal your Macintosh acts like a terminal connected directly to the computer.  You can use any editor that you could use if you were 
directly connected to the computer, using the type of terminal that TOPS Terminal is emulating.  

The process is simple; after starting up TOPS Terminal:

1. Select Terminal Session in the Network menu.
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2. Select an account and click Connect.

3. Start up an editor on the remote computer.

4. Log off when editing is complete.

5. Click the close box to close the session window.

Note:  you can use many editors in terminal emulation mode, including emacs, vi, and ed on a UNIX computer.  But you cannot use editors or text 
processors such as Microsoft Word or MacWrite; these work only on a Macintosh.  And since your Macintosh is emulating a terminal during a 
terminal session, it can't also act like a Macintosh.  

Editing Files with TOPS

Since the text editor built into TOPS Terminal allows you to edit local as well as remote files, you may also edit files that you have mounted as a 
local volume from a remote TOPS server.  For example, if you have mounted a directory from an IBM PC or a Sun Workstation located on a TOPS 
Network, you can use the TOPS Terminal text editor to edit text files within that directory.  The file will automatically be converted into the form 
required by the Macintosh when you open it and reconverted to the proper format when you save the edited file.  

Editing text files from TOPS-mounted volumes is a variation of local editing on TOPS Terminal; see “Local Editing” on page 118 for more 
information.
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TOPS Terminal Printing 

You can print a TOPS Terminal session transcript or an editor document during a terminal or edit session with the Print Document command; you 
can also print part of a session transcript or an editor document during a terminal or edit session with Print Selection.  Use Print Many to print one or 
more documents.  You can also select TOPS Terminal text documents from the Macintosh Desktop and print them without starting up TOPS 
Terminal.  

Print Document 

After starting TOPS Terminal and during a terminal session or an edit session, do the following to print the current document:  

1. Select Print Document in the File menu.

The standard print dialog will be displayed (for a LaserWriter, in this case):

.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

Text Editing and Printing 22



.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

23 TOPS Terminal

2. Modify print instructions (optional) and click OK.

The document will be printed; you can cancel the printing with -.  ⌘ (Clover-period).  

Print Selection 

After starting TOPS Terminal and during a terminal session or an edit session, do the following to print the selected text in the current document:  

1. Select the text you wish to print.

Select the text you wish to print, as explained on page 112.

2. Select Print Selection in the File menu.
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The standard print dialog will be displayed.

3. Modify print instructions and click OK.

The selected text will be printed; you can cancel the printing with -.  ⌘ (Clover-period).

Print Many

After starting TOPS Terminal, do the following to print the selected file or group of files:  
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1. Select Print Many in the File menu.

The Print Many dialog will be displayed, asking you to select the files you wish to print:
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2. Select the file(s) you want to print and click Add.

Select a file you want to print and click Add to add the file name to the list at the bottom of the dialog window.  Select more files in the 
same way, changing to different folders or drives if you wish.  
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3. Remove files from print list, if you like.

If you decide you don't want to print one of the files you have added to the list, select the file in the list at the bottom and click Forget; the 
file will be removed from the list.
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4. Click Print Files.

Click Print Files when you have selected all the files you want to print; the standard print dialog will begin.  You can select the Cancel 
button anytime during the printing process.  
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Note: Print Many only prints text documents.

Printing Documents from the Desktop

You can print a TOPS Terminal editor document from the Macintosh Desktop just as you print other files.  Select the TOPS Terminal files you want 
to print, and then select Print in the File menu.   TOPS Terminal will start up, you will be asked to click OK, and the selected files will print.  When 
the printing is complete, TOPS Terminal will terminate and you will be back at the Desktop.  
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Appendix

A
Quick Reference Guide

This chapter displays TOPS Terminal menus, which include keyboard equivalents for TOPS Terminal menu functions, and summarizes step-by-step 
instructions for a number of procedures described in detail elsewhere in the manual.  

Menus and Keyboard Equivalents

Many TOPS Terminal menu functions can be performed from the keyboard.  To perform most functions, hold down the Clover key ( ) ⌘ and press the letter or 
character following the Clover.  Note:  you do not need to use upper case letters.  
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Functions in the Commands and Controls submenus require that you hold down the Option and ⌘ keys together, and then press the letter or 
character.  
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Manual Connections

Network Account 
Chapter 2

1. Select Terminal Session in the 
     Network menu.
 2. Select Manual TCP/IP and click 
     Connect.
 3. Select terminal type and click OK.
 4. Type computer address and click OK.
 5. Log on to computer in normal way.
 6. Work on the remote computer.
 7. Log off in normal way.
 8. Click the close box 

Phone Account 
Chapter 2

1. Select Terminal Session in the 
     Network menu.
 2. Select Manual Phone and click 
     Connect.
 3. Click Save or change name and click 
     Save.
 4. Select terminal type and click OK.
 5. Select baud rate and click OK.
 6. Type ATDT plus computer phone 
     number and press Return.
 7. Press Return when you see the 
     response CONNECT.
 8. Log on to computer in normal way.
 9. Work on the remote computer.
10. Log off in the normal way.
11. Click the close box.
12. Click Yes to kill the connection.
13. Click the close box again.
14. Click Yes to save transcript 
      changes, No to not save them.

Computer Descriptions

Creating a Description - Network Connection
Chapter 3

1. Select Computers from Settings 
     menu.
 2. Click the New button.
 3. Type the computer's name, location 
     (optional), and TCP/IP address.
 4. Select the operating system.
 5. Specify TCP/IP Timeout.
 6. Click OK.
 7. Click Done.

Creating a Description - Phone Connection 
Chapter 3

1. Select Modem from Settings menu
 2. Select modem type.
 3. Change phone settings and click 
     OK.
 4. Select Computers from Settings 
     menu.
 5. Click the New button.
 6. Type the computer's name, location 
     (optional), and phone number.
 7. Select operating system.
 8. Select the baud rate for the modem.
 9. Change communications settings, if 
     necessary.
10. Click OK.
11. Click Done.
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Modifying a Computer Description
Chapter 3

1. Select Computers from Settings 
     menu.
 2. Select computer and click Open.
 3. Modify the computer description.
 4. Click OK.
 5. Click Done.

Removing a Computer Description
Chapter 3

1. Select Computers from Settings 
     menu.
 2. Select computer and click Remove.

Account Descriptions

Computer from TOPS Terminal Memory
Chapter 3

1. Select Accounts from Settings 
     menu.
 2. Click New.
 3. Click Memory.
 4. Select a computer and click OK.
 5. Type your user name and password 
     (optional) and click OK.
 6. Select a terminal type and click OK.
 7. Click check boxes in Description of 
     an Account,  and click OK.
 8. Click Done.

Computer from a Sign-Up File
Chapter 3

1. Select Accounts from Settings 
     menu.
 2. Click New.
 3. Click Sign Up.
 4. Select sign-up file and click Open.
 5. Select a computer and click OK.
 6. Type your user name and password 
     (optional) and click OK.
 7. Select a terminal type and click OK.
 8. Click check boxes in Description of 
     an Account, and click OK.
 9. Click Done.

Create a Computer Description
Chapter 3

1. Select Accounts from Settings 
     menu.
 2. Click New.
 3. Click New.
 4. Type in a name for the new 
     computer and click OK.
 5. Type your user name and password 
     (optional) and click OK.
 6. Select a terminal type and click OK.
 7. Complete the computer description 
     and click OK.
 8. Click check boxes in Description of 
     an Account,  and click OK.
 9. Click Done.
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Modifying an Account Description
Chapter 3

1. Select Accounts from Settings 
     menu.
 2. Select account and click Open.
 3. Click check boxes and change 
     terminal type,  and click OK.
 4. Click Done.

Removing an Account Description
Chapter 3

1. Select Accounts from Settings 
     menu.
 2. Select account you want to remove 
     and click Remove.
 3. Click Done in List of Known 
     Accounts.

Automatic Connections

File Session
Chapter 3

1. Select File Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Type password (if necessary) and 
     press Return.

Terminal Session - Save Transcript
Chapter 3

1. Select Terminal Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Rename the file (optional) and click 
     Save.
 4. Type password (if necessary) and 
     press Return.

Terminal Session - Don't Save Transcript
Chapter 3

1. Select Terminal Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Type password (if necessary) and 
     press Return.

Terminal Session - Append Transcript
Chapter 3

1. Select Terminal Session in Network 
     menu.
 2. Check Append the transcript to an 
    existing file.
 3. Select an account and click Connect.
 4. Select a file and click Open.
 5. Type password (if necessary) and 
     press Return.
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File Transfers

Send File, Network Account
Chapter 5

1. Select File Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Select Send File in the Network 
     menu.
 4. Select file to send.
 5. Select transfer format.
 6. Type name for file on remote 
     computer (to change the name).
 7. Click Send.
 8. Select Goodbye from the Commands 
     menu.
 9. Click the close box.

Send File, Phone Account
Chapter 5

1. Select Terminal Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Start download process on remote 
     computer.
 4. Select Send File in the Network 
     menu.
 5. Select file to send.
 6. Select transfer format.
 7. Type name for file on remote 
     computer (to change the name).
 8. Click Send.
 9. Log off or select Goodbye from the 
     Commands menu.
10. Click the close box.

Receive File, Network Account
Chapter 5

1. Select File Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Select Receive File in the Network 
     menu.
 4. Select file to receive (change 
     directories, if necessary).
 5. Select transfer format.
 6. Type name for file on your 
     Macintosh (to change the name; 
     change folders if you wish).
 7. Click Receive.
 8. Select Goodbye from the Commands 

     menu.
 9. Click the close box.

Receive File, Phone Account
Chapter 5

1. Select Terminal Session in Network 
     menu.
 2. Select an account and click Connect.
 3. Start upload process on remote 
     computer.
 4. Select Receive File in the Network 
     menu.
 5. Type the name of the file you want 
     to copy.
 6. Change the file name on your 
     Macintosh (optional).
 7. Select transfer format.
 8. Click Receive.
 9. Select Goodbye from the Commands 
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    menu.
10. Click the close box.

Text Editing & Printing

Local Editing - Create a New Document
Chapter 6

1. Select New in the File menu.
 2. Type a file name and click New.
 3. Type the new document.
 4. Select Save in the File menu.
 5. Click the close box.

Local Editing - Edit an Existing Document
Chapter 6

1. Select Open in the File menu.
 2. Select a file and click Open.
 3. Edit the document.
 4. Select Save in the File menu.
 5. Click the close box.

Remote Editing - Network Account
Chapter 6

1. Select File Session in the Network 
     menu.
 2. Select an account and click Connect.
 3. Select Edit File in the Network 
     menu.
 4. Select a document.
 5. Select Receive.
 6. Edit the document.
 7. Select Save in the File menu.
 8. Click the close box.
 9. Select Goodbye in Commands menu 
     when you are finished editing.
10. Click the close box in the terminal 
      session window.

Using an Editor on a Remote Computer
Chapter 6

1. Select Terminal Session in the 
     Network menu.
 2. Select an account and click Connect.
 3. Start up an editor (e.g., vi, emacs, 
     ed) on the remote computer.
 4. Save document and log off when 
     you finish editing.

 5. Click the close box.

Printing the Current Document
Chapter 6

1. Select Print Document in the File 
     menu.
 2. Click OK.

Printing Selected Text in the Current Document
Chapter 6

1. Select the text you wish to print.
 2. Select Print Selection in the File 
     menu.
 3. Click OK.
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Printing a Number of Documents
Chapter 6

1. Select Print Many in the File menu.
 2. Select the files to print and click 
     Add.
 3. Click Print Files.
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Appendix

B
Preference Settings

This appendix explains Your Preferences in the Settings menu.  TOPS Terminal interprets keyboard input, manages screen output, and tends to 
several other functions according to internal settings stored in your TOPS Terminal Memory.  You can change the settings at any time by selecting 
Your Preferences in the Settings menu:  

You will see the following dialog window: 
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The first word in each entry (Editor, Network, or Terminal) tells you what TOPS Terminal function the entry has to do with.  Editor entries have to 
do with local or remote editing.  Network entries are generally about Network menu functions.  Terminal entries are concerned with terminal sessions 
on a remote computer.  There is some overlap, since terminal sessions are started from the Network menu, for instance.  

To view or change a setting, double-click the preference item (or select it and click Open).  If you want to change the setting, select your preference 
in the displayed dialog window and click OK.  Whatever changes you make in the settings will take effect immediately and will be saved in TOPS 
Terminal Memory; they will be in effect for subsequent TOPS Terminal sessions.  

If you are unclear about what one of these preferences means, click the Help button in the dialog window for the preference you are interested in.
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Find Wraparound

Designates whether Find and Replace (in the Text menu) wrap around the bottom or the top of the file (depending on whether it is a forward or 
backward find or replace).  The default is wrap around.
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Printing Font

Determines what font will be used when you print from TOPS Terminal (File menu).  The default value is:  Monaco 9 point.
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Full Menus

Determines whether short or full Network and Settings menus will be displayed.  Short menus are the default.  

When you first use TOPS Terminal the short versions of the Network and Settings menus are displayed.  Most of the time you can do everything you 
want with the short menus.  If you want to do certain additional functions, you will have to display the full menus.  To display the full menus, do the 
following after starting up TOPS Terminal:

1. Select Your Preferences in the Settings menu.

The list of preferences will be displayed:
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2. Select Network - Full Menus and click Open.

The following dialog will be displayed:

3. Select Display the full Settings and Network menus and click OK.

When you click OK, whatever was displayed before you selected Your Preferences will be redisplayed; you will see full Network and 
Settings menus if you select those menu headings.  The additional functions available with full menus are discussed below.
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Additional Network Menu Functions

Three additional functions are available with the full Network menu:  

•  Kill a “stubborn” connection to a remote computer
•  Reset the terminal settings on a remote computer 
•  Execute a macro on a remote computer 

Kill Connection, Reset Terminal, and macro execution are described in Chapter 4.  See Appendix D to learn how to write a macro.  

Additional Settings Menu Functions

The full version of the Settings menu has four additional functions:  

• Describe or modify an operating system description
• Describe or modify a service description
• Create or modify a script 
• Create or modify a macro
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See Appendix D for detailed descriptions of scripts and macros.  See Appendix E for information about operating system and service descriptions.  

Local Copy on Edit

Determines whether TOPS Terminal will retain a local copy (on the Macintosh) of a file you edit with Edit File command (Network menu).  The 
default is to save a local copy.  
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Maximum Number of Sessions

Determines the maximum number of network connections allowed at one time; the default value is 20.  If you find yourself running out of memory 
regularly, you might want to reduce the number.  

Remember Passwords

Determines whether a password for an account you connect to is saved in RAM (Random Access Memory) until you quit TOPS Terminal, or if the 
password will be forgotten immediately.  The default option is to remember passwords.  This means that you will not have to type the password 
again if you make a connection with the same account more than once during a TOPS Terminal session.  It also means that anyone else who has 
access to your Macintosh can log on to any computers you have logged onto during the current TOPS Terminal session.  

The most secure option is to select Forget passwords as soon as possible.

Note that this setting has nothing to do with whether account passwords are saved in TOPS Terminal Memory; you set up each account separately 
and determine whether or not you want the password stored with the account.  See Chapter 3.
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Temporary Folder 

Allows you to specify where “temporary” session transcripts will be saved; all file session transcripts are temporary, as are terminal session 
transcripts for accounts in which Don't Save Session Transcript has been checked.  The folder shown at the top of the list box (“TOPS folder” in the 
example below) is the folder where transcripts will be saved — should you decide to select Save during the session.  Double click on a folder in the 
list box to select it.  
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Character Set

Determines what VT100 character set should be used during a TOPS Terminal session; American is the default.  

Control Keys

Determines whether the ⌘ (Clover) key or ⌘-Shift will be used as a Control-key equivalent on Macintoshes with no Control key (the Macintosh 
Plus and below); Clover-Shift for Control is the default.  

Mac shortcuts, as described in “Mac Shortcuts for Menu Selection” in Chapter 4, use the Clover or Clover-Shift sequence that control keys do not 
use.  If you tend to use Mac shortcuts more than Control-key sequences, you will probably want to change the setting.  
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Escape Key

Determines whether the backquote key by itself or -` (⌘ Clover-backquote) will be used as escape-key equivalent on Macs with no escape key (the 
Macintosh Plus and below); Clover-backquote is the default.  

Monitoring

Determines whether an exact copy of the characters that come in from the network or the modem are saved in an auxiliary file which can then be 
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viewed with a binary file editor such as Fedit Plus.  This may be useful to a system administrator in diagnosing problems.  Don't monitor is the 
default.  
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Text Wrapping

Determines whether text in terminal sessions will extend beyond the right edge of the window, with the horizontal scroll bar active, or if text will 
automatically wrap around to the left margin when the right edge of the window is reached; wrap around to the left is the default.  Note that this is 
not word wrapping:  words may be split in two at the end of a line.  Use the Return key to prevent word splits.  

Note also that this setting does not affect editing sessions on TOPS Terminal; you must press Return at the end of lines during editing sessions if you 
wish the text to continue on the following line.  
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Appendix

C
Modems

If you are going to make TOPS Terminal connections to a remote computer with a phone account, you will need to have a modem attached to your 
Macintosh (or a shared network modem such as Shiva NetModem) and you will have to select a modem type before making a connection.  

If no built-in modem description matches the settings of the remote computer you wish to connect to, you will have to create a modem description 
with the proper modem/phone settings.  

This appendix explains how to select a modem type and how to create, modify, or remove a modem description.  

Note:  see your system administrator or the system administrator of the remote computer you wish to connect to if you are unsure about modem and 
phone settings.  

Selecting a Modem Type

To select a modem type, do the following after starting TOPS Terminal:  

1. Select Modem from Settings menu
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2. Select a modem type and click OK.

Creating a Modem Description

To create a modem description to match the modem settings of a remote computer you wish to connect to, do the following:  

1. Select full menus in Your Preferences.
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55 TOPS Terminal
See the instructions for displaying full Network and Settings menus on page 143 of Appendix B.  You need to display full menus preference 
settings to create, modify, or remove modem descriptions.  

2. Select Modem in Settings menu.  

The list of modem descriptions will be displayed, with Edit, New, and Remove buttons at the bottom of the dialog window:  

3. Select New.

A blank Description of a Modem will be displayed:.  
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4. Type the name of the modem description.

Use a descriptive name that will remind you of the characteristics of the modem, with reference to the brand name and its speed, for 
instance.  

5. Select baud rate(s) for the modem.

Select a baud rate for the modem, or select a number of baud rates (use ⌘-Option for multiple selections) if the modem has variable rates.  
We selected 9600 baud in the example below.  

6. Select dialing and hangup scripts.

If you need to use different scripts than the default scripts automatically selected, select the script you want to change and select a different 
script from the list displayed.  See Appendix D for a discussion of scripts.  

7. Change other settings and click OK.

Change the Disconnected message and the D. Term Ready, Clear To Send, and Printer Port settings, if necessary.  Also change the 
designation for Tone or Pulse dialing, if necessary.  Click OK when the description is complete.  

Here is a completed modem description, for a Hayes 9600 baud modem:
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Modifying a Modem Description

Note:  You cannot modify the built-in modem descriptions that come with TOPS Terminal.  You can, however, make changes to one of these 
descriptions, select Save As in the File menu, and save the modified description with a different name.  

To modify a modem description to match the modem settings of a remote computer you wish to connect to, do the following (with full menus 
selected):  

1. Select Modem in Settings menu.  

2. Select the modem you wish to modify and click Edit.  
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3. Modify the description and click OK.  

Make changes to any of the settings, including baud rate and dialing or disconnect scripts, and click OK.  

Removing a Modem Description

To remove a modem description, do the following (with full menus selected):  

1. Select Modem in Settings menu.  

2. Select the modem you wish to remove and click Remove.  
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Appendix

D
Scripts & Macros

Scripts and macros are miniature computer programs that execute a sequence of operations during terminal or file sessions.  For example, when you 
start a terminal session and choose an account to connect to a remote computer, TOPS Terminal calls a pre-defined (“built-in”) login script that 
identifies you to the computer.  Other scripts perform functions such as copying files from your Macintosh to a remote computer, listing files on a 
remote computer, and logging off from a remote computer.  Scripts are also invoked by TOPS Terminal when you select a function in the full 
Network menu.  

Scripts are matched to particular computers and particular operating systems; each built-in operating system description has a script that performs the 
login identification function for that operating system.  (See Appendix E for a discussion of operating systems.)  

Macros are identical in format and syntax to scripts, but they are invoked by you directly.  TOPS Terminal doesn't provide any macros; you write 
them yourself and execute them by selecting Macros in the Network menu and selecting the macro you want to run from the list.  

Writing Scripts and Macros

A number of built-in scripts come with TOPS Terminal, and they may be all you need.  If you want to connect to a computer with an operating 
system for which there is no built-in description in TOPS Terminal, you 
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may need to write your own scripts.  

Before trying to write a script or macro, open up some of TOPS Terminal's built-in scripts to see what they look like.  To do this, select Scripts from 
the Settings menu (available only when full menus are displayed; see Appendix B to learn how to display full menus).  

The List of Network Scripts will be displayed; scroll through the list to see what is available.  Many of the scripts are for commands on UNIX and 
VMS operating systems.  

Scroll down the list, select any of the scripts, and click Open to display the text of the script.  Select the UNIX Log In script, for instance (remember 
that you can just press the letter U to jump immediately to the first entry in the list that starts with U).
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Click Open to display the UNIX Log In script:

Look at some other scripts, if you like, and then read on to learn how you can write your own scripts and macros.  

Format of Scripts and Macros

As you can see from the example above, scripts and macros take the form of a sequence of questions and answers.  When a script is active, TOPS 
Terminal looks at all the data sent from the remote computer, trying to match the questions in the script.  When it sees that the remote computer has 
asked the Mac one of the listed questions, TOPS Terminal gives the corresponding answer from the list of questions and answers.  

Look again at the UNIX login script above.  The first two questions it looks for are “*login: ” and “Password: ”.  This is how UNIX asks for your 
user name and your password.  TOPS Terminal spots these questions when they are asked by UNIX, and it gives the corresponding answers, “(user 
name)(cr)” and “(password),” respectively.
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On the other hand, if TOPS Terminal sees “Login incorrect,” the user name or the password is wrong or garbled.  UNIX is telling you something 
went awry and (implicitly) questions you:  Would you like to try again?  The answer to “Login incorrect” is “(retry 3)”, meaning to start the login 
process again a maximum of three times.

Text in a script's question ordinarily matches only identical text from the remote computer, but there are special characters like the asterisk which 
have special pattern matching implications.  One such use was shown in the question “*login: ” above; the asterisk and two other special characters 
are discussed in “Syntax  of Scripts and Macros,” below.  

Text in a script's answer is sent directly to the remote computer when the answer is encountered, unless the text is within parentheses.  Text in 
parentheses has a special meaning.  In the UNIX script, for instance, “(user name)(cr)” means “Send the user name for the account I'm calling, then 
send a carriage return.”  A list of special answers (“built-in commands”) is shown on page 174.

A script can start with an answer which is not preceded by a question.  Consider this Hayes dialing script:

Answer: ATM0 (cr)
Question: OK
Answer: ATD (phone number)

The script first turns off the modem speaker with the modem command, “ATM0.”  It then looks for “OK,” and upon receiving that, sends “ATD” 
(the Hayes Modem dialing sequence) plus the phone number of the computer you are trying to connect to.

Syntax of Scripts and Macros

The syntax of questions and answers is described below.  Note that script and macro text is case-sensitive; that is, lower-case “word” is different than 
initial-cap “Word.”  Note also that the colon after Question or Answer is followed by one or more spaces or tabs.  Normally, no space should be 
inserted between text and built-in commands.  

Question syntax

The text of a question is a sequence of characters, a special character, or a combination of both which is matched against responses from the remote 
computer.  For example, “Question:  login:” tells your Macintosh to look 
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for the pattern “login:” from the remote computer, which is the computer's way of saying it is ready for you to type your user ID and log in.  

There are three special characters that can be combined with other text to vary the meaning of the question:  

• An asterisk (*) matches any pattern sent by the remote computer, except an end-of-line character.

Question: *word:  
will match “Password:”, “password:”, or “suntops password:”.  

• The vertical bar ( | ) separates two or more patterns; a match of any of the patterns is a successful match.  

Question: BUSY|NO CARRIER|NO DIALTONE
will find a match if the remote computer sends any of these character sequences.

• A back slash (\) signifies the end of line.  

QUESTION:  entry\
will find and match any line sent from the remote computer
which ends with the word “entry”

Answer syntax

The text of an answer is text, a special answer (built-in command) in parentheses, or a combination of both.  The text and commands that follow 
Answer: are sent to the remote computer.  Example:  

Answer:    (user name)(cr)

The user name found in the account description for the computer you are connected to is sent to the remote computer, followed by a carriage return.  
Built-in commands are listed at the end of this chapter, on page 174.  

Question-Matching Order

The “current question” is a reference point used by TOPS Terminal when a script or macro is running.  When a script or macro starts, the first 
question is the current question.  When a question is matched, the answer or answers 
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that immediately follow are executed, and the next question after the one that was matched becomes the current question.  

The script or macro ends when the last answer or the special answers “(success)” or “(failure)” are executed.

The questions in a script or macro may not be processed in the order they are listed.  All data is checked against each question in the script to see if it 
matches the question.  Sometimes questions are similar enough to each other that data could match more than one question; when this happens, the 
order of matching becomes a significant issue.  

TOPS Terminal first checks the current question for a match and then checks each succeeding question in order.  When the last question is reached, 
TOPS Terminal goes back to the start and checks the first question and each succeeding question until the current question is encountered again.  

In summary, question matching is cyclical:  the script or macro is checked for a successful match with the current question, then for questions 
between the current question and the end of the script or macro, then from the top again.  The checking stops at the first matching question 
encountered, or when the circle comes back around to the current question, whichever comes first.  

Example 1 - a Login Script

1. Select Scripts in the Settings menu.  

2. Select New.
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3. Type a name for the script.  

A blank edit window will be displayed:
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4. Type the script in the edit window.  

5. Save the script and click the close box.  

Select Save in the File menu to save the script and click on the close box.  The List of Scripts will be displayed, with the new script listed.  

Analysis of “compulogin”:  

When CompuServe asks for the “Host Name:”, TOPS Terminal answers with “CIS” and a carriage return.  When CompuServe asks for the “User 
ID:” TOPS Terminal answers with a user name (from TOPS Terminal Memory) and a carriage return.  When CompuServe asks for a password, 
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TOPS Terminal supplies the password included in the account description, or asks for the password from the user if there is no stored password.

The script keeps an eye out for a question that includes the phrase “Invalid entry.”  If this is found (because the password supplied by TOPS 
Terminal was invalid), it goes back to the very beginning of the script.  It will perform this cycle up to three times (“retry 3”).  If the user id and 
password taken from TOPS Terminal Memory fails to work three more consecutive times, the script fails and TOPS Terminal hangs up.  

On the other hand, if anything except “Invalid entry” arrives after the password is sent, “Question:  *” is matched, and the corresponding answer — 
“(success)” — finishes the process of identifying you.  

Example 2 -  a Macro to Read Messages

Consider, now, a macro called “macro 1” which will also be used with CompuServe.  This macro will be executed when you select it from the list of 
macros available under the Network/Macros menu.  Follow these instructions to create the macro:  

1. Select Macros in the Settings menu.

The List of Macros will be displayed; if you have not written any others, none will be listed:
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2. Select New.

You will be asked to name the macro:

3. Type a name and click OK.

A blank editor document will be opened; the status box at the lower left will read “Editing a Macro.”  

4. Type the macro in the edit window.  
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5. Save the macro and click the close box.  

Select Save in the File menu to save the macro and click on the close box.  The List of Macros will be displayed, with the new macro listed: 

Analysis of “macro 1”:  

This macro reads all new messages from the CompuServe bulletin board for a particular “forum” (subject area) and records them in a TOPS 
Terminal session transcript.  Note that you must start the macro at the appropriate time — once inside the forum at the menu relevant to leaving and 
reading messages.  

First the macro sends “rn” and a carriage return, which is a request to Read New messages in a particular CompuServe forum.  You want 
CompuServe to send out the messages one-by-one until the phrase “JOIN this forum” is encountered, which will happen when there are no more 
messages to read; this will invoke the built-in command “(success),” which indicates that the macro ended successfully.  
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Two questions will appear in the course of message reading, and they must be answered by the macro to cause CompuServe to continue sending 
messages.  After each message has been read, CompuServe gives you the choice of reading the next message by pressing carriage return or typing 
“CHOICES!” to display other options.  The macro sends the answer “(cr)” to tell CompuServe to send the next message.

The second question occurs when there's not enough room on the screen for the whole message.  CompuServe asks for a carriage return to continue 
the message, which the macro sends when it sees the question “Press <CR> for more:” 

Messages are read until there are no more to read and the macro ends successfully.  
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Testing and Editing Scripts and Macros

Once you have written a script or macro, you will want to test it and edit it if it does not do exactly what you want it to.  Since scripts and macros 
have the same format and syntax, they can be tested in a similar manner.  TOPS Terminal provides you with a way to test a script as a macro before 
you install it in a service description.  

Debug Command

Use the built-in command “debug” to tell when a particular answer is reached.  For example, “Answer: (debug step 3)” will put “step 3” on the 
screen when that answer is reached; the text is not sent to the other computer, but is displayed in the session window.  You can move the debug 
answer around to see where the script or macro fails.  

Testing or executing a Macro

To test or execute a macro, do the following:  

1. Make a connection to a remote computer.  

Macros are executed on a remote computer after you have made a connection with TOPS Terminal.  The Macros menu is only active during 
a terminal session on a remote computer.  

2. Prepare for the macro on the remote computer.  

Depending on what the macro does, you may need to change directories or start a process on the remote computer before executing the 
macro.  

3. Select Macros in the Network menu.  

Click and hold the mouse button on the Network menu and move the mouse until Macros (available only with full menus) is highlighted, 
which will display the Pick Macro command and a list of the macros you have written:    
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4. Select macro to execute and release the mouse button.  

The selected macro will be executed.  If it doesn't do what you expected it to, edit the macro and execute it again.  

Testing a Script

The process of testing a script is much like that for executing a script.  Do the following:  

1. Make a connection to a remote computer.  

Scripts, like macros, are executed on a remote computer after you have made a connection with TOPS Terminal.  
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2. Prepare for the script on the remote computer.  

Depending on what the script does, you may need to change directories or start a process on the remote computer before executing the 
script.  

3. Select Macros in the Network menu.  

Click and hold the mouse button on the Network menu and move the mouse until Macros (available only with full menus) is highlighted, 
which will display the Pick Macro command and a list of the macros you have written:    

4. Select Pick Macro and release the mouse button.  
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The macros you have written will be displayed in a dialog window, with four buttons, including Script, at the bottom.  

5. Select the Script button:  

This will display the list of scripts and let you run a script as if it were a macro.  You may want do this during a manual terminal session (as 
described in Chapter 2).  

For example, to test the login script for CompuServe from Example 1 above, start up a manual terminal session to CompuServe and then:

6. Select the script you want to test.  
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7. Click OK.  

The script will be executed.  If the script does not work properly, edit it and test it again as a macro.  Once the script works properly, install 
it as the login script for the CompuServe service, as described in Appendix E.  

Editing a Script or Macro

To edit an existing script or macro, do the following:  

1. Select Scripts or Macros from the  Settings menu:
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The list of network scripts (or the list of macros you have written) will be displayed.  

2. Select a script or macro and click Open 

3. Edit the script or macro and save it.  

Modify the script or macro and  save it by selecting Save in the File menu, and click the close box when you are finished.  

Note:  you cannot modify a built-in script, but you can make changes to one and rename it using Save As in the File menu.
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Built-In Commands

TOPS Terminal provides various types of built-in commands that you can use in script and macro answers:  

CONNECTING AND IDENTIFYING:
  first name send first name from user name
  last name send last name from user name
  user name send user name of this account
FILE NAMES:
  source send name of source file
  target send name of target file
FILE TRANSFER: 
  file type send type string entered for file
  FTP abort kill an ongoing FTP transfer
  FTP connect listen for the FTP data port connection
  FTP port negotiate an FTP data port
  FTP receive receive file via FTP
  FTP send send file via FTP
  XMODEM sendsend file via XMODEM
  XMODEM receive receive file via XMODEM
GENERAL PURPOSE:
  debug print the following string on the screen
  hang up kill the connection rudely
  interrupt send the interrupt control sequence
  no operation don't do anything
  pause wait for one second
MODEM CONTROL:
  phone number send the phone number of this computer
PASSWORDS:
  new password get the new password and send it
  password send password of this account
  update passwordsave the new password (if appropriate)
SPECIAL CHARACTERS:
  break send a special break sequence
  cr send a carriage return
  return send a carriage return
  space send a white space
  tab send a tab character
SUCCESS, FAILURE, AND TRYING AGAIN:
  failure terminate the script and report failure
  retry n go back to the start of script (at most n times)
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 start over retry the previous question
  success finished with the script, accomplished the goal
TARGET TWIDDLING:
  random target put a random number in the target name
  include target read target file and insert into session transcript
  trash target delete the target file
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Appendix

E
Operating Systems & Services

This appendix explains how to expand or customize TOPS Terminal's interfacing capability by creating new operating system and service 
descriptions.  Also included is a discussion of the hierarchical structure of TOPS Terminal.  

An operating system is the controlling program of a computer, and it determines how you talk to the computer for such functions as logging in, 
logging off, listing files, deleting files, etc.  To make it easy for you to perform various functions on a remote computer, TOPS Terminal must 
interface with the computer's operating system.  This interface is facilitated by the inclusion of a number of built-in operating system descriptions:  
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Hierarchy of Descriptions

Operating system descriptions provide various terminal session and file transfer services for a wide variety of remote computers, and these services 
are provided under a consistent and uniform interface, hiding many of the details of the interaction with the remote operating system.  

This “operating system independence,” as it is called, means that you can perform many common operations on a remote computer without knowing 
how they get implemented within the operating system of that computer.  For instance, you can call a computer and identify yourself, see what files 
are on that computer, copy one of the files, and log off from the computer, all using the Macintosh's easy menus and dialogs, without knowing 
anything about the remote operating system.

To perform these functions on the remote computer, TOPS Terminal uses built-in scripts (see Appendix D) that are linked to a particular operating 
system.  Each of the operations under the Network menu (Terminal Session, File Session, Send File, Receive File, etc.) and each selection under the 
Commands and Controls submenus corresponds to a particular script.  

To keep track of which scripts go with which operating system on which computer, TOPS Terminal uses a hierarchical system of descriptions.  Each 
description utilizes information at the next level down in the hierarchy, as illustrated in the chart on the opposite page.  

At the top of the hierarchy is the account description (level 1).  The account description includes the name of a remote computer, which has been 
specified in a TOPS Terminal computer description (level 2).  The description of the remote computer specifies an operating system description 
(level 3).  The description of the operating system, in turn, specifies its terminal session and file transfer services (level 4).  The description of a 
terminal session or file transfer service includes a catalog of all the scripts (level 5) that are used by TOPS Terminal to perform that service.  

What the hierarchy of descriptions means in practice is that whenever you select an account for a terminal emulation or a file transfer session, you 
are automatically selecting the scripts needed by TOPS Terminal to perform the terminal or file transfer functions you want to perform for that 
account.  
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If you want to expand or customize TOPS Terminal's interfacing capability, you must write the appropriate scripts, link them to a terminal or file 
transfer service, and link this service to a new operating system description.  These steps are explained on the following pages.  The new operating 
system description is then linked to a computer description, which is linked to an account, as described in Chapter 3.  
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Built-In Operating Systems & Services

TOPS Terminal's built-in operating system descriptions are shown in the table below along with the terminal service and file transfer service 
associated with each.  Note that some operating system interfaces (UNIX and VAX/VMS) provide terminal service for both phone and network 
connections, and file transfer service for network connections only.  FidoNet and Red Ryder Host provide no network connection services.  Note also 
that no file transfer services are available for phone connections.  (File transfers for network and phone accounts are described in Chapter 5.)  

Operating
System Phone Connection        Network Connection

Terminal Service Terminal Service File Transfer Service

FidoNet FidoNet Commands (None) (None)
Red Ryder Host Red Ryder Host (None) (None)
UNIX UNIX Shell UNIX Shell FTP Commands
VAX/VMS VMS Command Interp. VMS Cmnd Interp FTP Commands
Unknown OS Manual Manual FTP Commands

Each of the services in the table represents a group of scripts that TOPS Terminal invokes to perform terminal session (Terminal Service) or file 
transfer session operations (File Transfer Service).  

To see the catalog of scripts used by any service, select Services from the Settings menu and then select a service from the list.  Note that Services is 
available only when full menus are displayed (see Appendix B).  
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Here is the UNIX Shell service, for instance:

The bold entries (login, goodbye, list, etc.) are functions under TOPS Terminal's Network menu and Commands submenu.  The text to the right of a 
function is the name of a script in TOPS Terminal.  

Click on a script to display a list of all available scripts; for example, click on UNIX Log In:  
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The list of TOPS Terminal scripts will be shown, with the one selected highlighted:

You're just looking at the list now, but you could substitute another script for that function, if you wished to, by selecting a script from the list and 
clicking OK.  Or you could click Edit if you wanted to modify the script (see Appendix D).

An operating system description, illustrated by the built-in UNIX operating system description below, includes:

•  Operating system name (UNIX in the example below)
•  Services available with the operating system (FTP Commands 
   and UNIX Shell, in this case)
•  Control-key equivalents (Zap Process = Control-backslash, etc.)
•  Designation for the current and parent directories (for a UNIX
   system one period = current directory, two periods = parent 
   directory)
•  Whether keyboard entry is echoed by your Macintosh (Local
   Echo)
•  Whether backspace (ASCII 8) or DEL (ASCII 127) is sent when 
    you press the Backspace or Delete key
•  End-of-line convention for the operating system (Carriage 
   Return, Line Feed, or Carriage Return-Line Feed)
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Operating System Interface

To create a new operating system interface, you start at the bottom of the hierarchy, using scripts appropriate to the new operating system to create a 
new terminal or file transfer service.  This new service is then used to create a new operating system description.  

Suppose, for example, you wish to set up a CompuServe operating system interface that uses the login script shown as an example in Appendix D, 
“Scripts and Macros.”  First you will use the new login script to set up a terminal service description; then you will use the new terminal service 
description to set up a new operating system description.
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Service Description

Terminal session and file transfer services are basic elements of an operating system interface.  Create a service description, as follows:

1. Select Services from the Settings menu. 

The list of described services will be displayed:  

2. Click New.  

A blank service description will be displayed:
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3. Type the name of the service.

We will call the service “CompuServe” in this example.  

4. Click on a script.

We will click on the login script.  

The list of TOPS Terminal scripts will be displayed, with No Script selected.

5. Select a script and click OK.
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90 TOPS Terminal

We have selected “compulogin,” the login script written as an exercise in Appendix  D.  The CompuServe service will be displayed, with 
“compulogin” listed as the login script:  

If you knew which built-in scripts would work with CompuServe, you could now fill those in as you did for login; you would probably 
want to include XMODEM send and receive, for instance.  In this case, we will only include the login script.  
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6. Click in the Phone Service and/or TCP/IP Service boxes.

Click one or both of the boxes, depending on what kinds of connections are available on the remote computer.  We have checked Phone 
Service in the example above.  

7. Enter TCP/IP Port number.

Check with your system administrator.  The standard TCP/IP number for terminal emulation service (TELNET) is 23; the standard number 
for file transfer service (FTP) is 21.  We did not enter a number in the above example, since TCP/IP Service was not checked and this 
number is only needed for a TCP/IP service.  

8. Select Terminal Service or File Transfer Service.

Select one or the other — Terminal Service if you are defining a service for making terminal session connections to a remote computer — 
or File Transfer Service if you are defining a service for file session connections.  We checked Terminal Service in the example; remember 
that file transfer services are only available for network connections.  

9. Click OK.  

The list of network services will be displayed, with CompuServe now added, in alphanumeric order.
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Note:  you can modify an existing service description by selecting it from the list of services and clicking Open.  Note that you cannot modify the 
built-in service descriptions that come with TOPS Terminal; you can, however, make changes to one of these descriptions and give it another name 
by selecting Save as in the File menu.  You can remove service descriptions that you create by clicking Remove.  

Operating System Description

Once you have created scripts and services, you are ready to create an operating system description.  Follow these instructions:  

1. Select Operating Systems from the Settings menu.
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(Operating Systems is only available in full Settings menu; see Appendix B for information about full or short menus in Your Preferences.)  

2. Click New.  

A blank Description of an Operating System will be displayed; “CompuServe” will be listed as one of the available services.  

3. Type name of operating system.

In this case, we will use “CompuServe” as the name of the operating system.  

See your system administrator if you are not sure about any of the settings discussed below.

4. Select services.

Select one or more services from the list of service descriptions; in this case, we have selected CompuServe only.  (Hold down the Option 
and Clover ( ) ⌘ keys to select more than one item in a list.)

5. Enter control codes.

Type the control codes appropriate for the operating system.  

6. Fill in directory boxes.

Enter the current and parent directory designations for the operating system.  

7. Click in check boxes.

Click in the check boxes for Local Echo, DELETE key, and end of line convention for the operating system, as appropriate.  

Local Echo determines whether or not keyboard entry is echoed by your Macintosh.  

DELETE key determines what acts as the delete key.  Check this box for VMS operating systems.  
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The buttons labeled CR, LF, and CRLF stand for Carriage Return, Line Feed, and Carriage Return Line Feed.  This should match the end of 
line convention used by XMODEM on the other machine.  Use LF for UNIX, CRLF for VMS.  

8. Click OK.

You have completed the operating system description.  The final steps in the process of preparing for an automatic connection would be to 
create a computer description that selects this operating system and to create an account description that specifies that computer description 
(see Chapter 3).  

Note:  you can modify an existing operating system description by selecting it from the list of operating systems and clicking Open.  Note that you 
cannot modify the built-in descriptions that come with TOPS Terminal; you can, however, make changes to one of these descriptions and give it 
another name by selecting Save as in the File menu.  You can remove operating system descriptions that you create by clicking Remove.  
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Appendix

F
Sign-Up Files

Sign-up files are used to make computer descriptions available to other TOPS Terminal users.  A computer description is created in TOPS Terminal 
Memory and copied to a sign up file, which is made available to other users on a network file server or on a floppy disk.  

Generally a sign-up file is created and distributed by the system administrator.  If you are a system administrator, you may need to create or modify a 
sign-up file.  TOPS Terminal makes this process extremely easy.

Creating a Sign-Up File

A sign-up file is created by copying computer descriptions from TOPS Terminal Memory on your Macintosh, so be sure the descriptions you want to 
copy are available before doing the following:  

1. Select full menus in Your Preferences.

The file format Sign-Up File is only available when full menus are selected.  See Appendix B if you do not know how to change settings in 
Your Preferences.  

2. Select New in the File menu.
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A file selection dialog will be displayed, with the new file name shown as “Untitled” and with Text (Macintosh) selected as the file format:
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3. Type a file name and select Sign-Up File format.

In the example below the sign-up file has been given the name “Signup 2.”  There are no special rules for sign-up file names.

 

4. Click New.

The sign-up dialog will be displayed, showing the computers described in TOPS Terminal Memory on the left and the computers in the 
sign-up file on the right:

There are no computers listed on the right since you are creating a new sign-up file now.  You are going to copy computer 
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descriptions from TOPS Terminal Memory into the new sign-up file.

5. Select computer(s).

Select a computer or a number of computers from the list on the left.  You can select and copy them one at a time, but more likely you will 
want to select all that you want to copy and then copy them all at once.  Use the Option-⌘ sequence, as described in Chapter 1, to select 
multiple computer descriptions.  

6. Select Copy.

Select Copy to copy the computer descriptions that you want in the sign-up file. 

When you are finished the sign-up dialog window will look something like this:
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7. Click OK.

The sign-up dialog will disappear.  The new sign-up file is ready to be used for selecting computers when describing a new account (as 
shown in Chapter 4).  

8. Quit TOPS Terminal.

All that is left to do is make the sign-up file available to other TOPS Terminal users.  To do this you need to quit TOPS Terminal (File/Quit) 
and distribute the sign-up file.  

9. Distribute the sign-up file.

Copy the sign-up file to floppy disks and distribute to TOPS Terminal users or copy the sign-up file to a file server on your local network, 
for use by TOPS Terminal users when they describe new accounts.  

Editing a Sign-Up File

Editing a sign-up file means copying new computers to an existing sign-up file or removing computers from a sign-up file.  
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With full menus selected in Your Preferences in the Settings menu:

1. Select Open in File menu.

Note that sign-up files will not be listed if you have selected short menus in Your Preferences.

2. Select Sign-up file to edit.

3. Click Open.

The selected sign-up file will be displayed, with TOPS Terminal Memory computers on the left and sign-up file computers on the right.

4. Copy or Remove computers.

To copy  a computer from TOPS Terminal Memory to the sign-up file, select a computer in the list on the left and click Copy; the computer 
will be copied to the sign-up file.  If you specify a computer with the same name as one listed in the sign-up file, the old description will be 
overwritten.
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To remove a computer from the sign-up file, select a computer in the list at the right and click Remove; the computer will be removed from 
the sign-up file.
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Appendix

G
System Administration Guide

This guide discusses a number of topics related to assigning IP addresses to TCP/IP hosts and TOPS Terminal Macintoshes on a local area network.  
It is intended for use by someone experienced with IP (Internet Protocol) addressing; as such, it is not written at the basic-user level of much of the 
rest of the manual.   

In most situations, TOPS Terminal will be installed on one or more Macintosh stations which are then connected into an existing Ethernet network.  
The host computers on the Ethernet network will have been assigned IP addresses, and the system administrator's task will be to assign IP addresses 
to the TOPS Terminal Macintosh stations on the network as well.

If the Macintosh station is directly connected to Ethernet using either an Ethernet card or a SCSI device, the assignment of addresses is relatively 
straightforward.  The Macintoshes are considered to be an extension of the Ethernet network and the same addressing scheme is used as in the 
remainder of the network.  

Normally, however, Macintosh stations will not be directly connected to Ethernet; Macintoshes (on Appletalk) will be connected to Ethernet using an 
Appletalk/Ethernet gateway.  This is a more complex addressing situation and is the main subject of this guide.

•  Basic Concepts describes the structure of IP addresses and introduces the concept of dynamic addressing.

•  IP Addressing With A Gateway discusses the situation in which Macintosh stations on an Appletalk network are connected 
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to Ethernet through an Appletalk/Ethernet gateway such as the Kinetics FastPath.  It explains the “subnetting” approach to IP addressing in a 

gateway situation.  

•  How to Set Up the Kinetics FastPath explains how to use the GateWayName program and the FastPath Manager program to configure a 
gateway.

 • Dynamic Addressing With Kipper explains how to use a KIP server, should you decide to dynamically assign IP addresses to your TOPS 
Terminal Macintoshes. 

Basic Concepts 

The Internet Address

Any station on a TCP/IP network must have a unique address — called an Internet or IP address — which specifies both the address of the network 
on the internet and the address of that station on the network.  

Each IP address is made up of four bytes.  A byte is an eight-bit binary number which can be represented by decimal (0-255) or hexadecimal (0-FF) 
equivalents.  This guide, and the TOPS Terminal configuration process, refer to the decimal representation only.  A sample IP address in decimal 
form is 191.29.101.16. 

IP addresses are divided into two parts:  a network number and a local address.  The network number identifies your network on a broad internet.  It 
is the same for all stations on a local Ethernet network.  The local address is unique for each station on that network.  

There are three addressing schemes for dividing the four bytes of the IP address into network number and local address.  The scheme used in any 
network is determined by the first byte or bytes of the address: 

   0 - 127  =   Class A address
128 - 191  =   Class B address
192 - 223  =   Class C address
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With a Class A address, the first byte is the network number, and the other three bytes are the local address; with a Class B address, the first two 
bytes are the network number and the last two bytes are the local address; and with Class C, the first three bytes are the network number, and the last 
byte is the local address:  

101

89

131 131

191 29

2 32 1

Network Number

Host Number

32 1

16

Class A:

Class C:

Class B:

Static vs. Dynamic Addressing

No matter which of these addressing scheme applies to your network, each station on the network must have a unique IP address.  One approach to 
assigning IP addresses is to assign a fixed address to each station.  This method, called “static addressing,” requires that you assign each TOPS 
Terminal station that you install on the network a unique address.

Another approach for addressing TOPS Terminal Macintoshes on an Appletalk or Ethernet network, is to let the network make the address 
assignments for you.  This method, called “dynamic addressing,” is standard for Appletalk addressing, and has been extended to IP addressing with a 
Macintosh program called Kipper, which is included on your TOPS Terminal master disk.  If you are connecting an Appletalk network to an Ethernet 
network through an Appletalk/Ethernet gateway, you can use Kipper to dynamically assign IP addresses to your TOPS Terminal stations.  The use of 
Kipper is described in the last section of this guide. 

IP Addressing with a Gateway

In the case where TOPS Terminal Macintoshes are connected to Ethernnet through an Appletalk/Ethernet gateway, IP addressing is complicated by 
the 
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fact that the gateway must distinguish between IP addresses on the Ethernet side of the gateway and those on the Appletalk side.  

One method for assigning IP addresses in this situation is to treat the entire network (Ethernet plus Appletalk) as one logical network on the internet. 
With this method, called “subnetting,” the network is broken down into two subnetworks (subnets) — one on the Ethernet side of the gateway and 
one on the Appletalk side.  IP addresses are assigned so as to distinguish between the two subnets.

Subnetting generally requires few changes to an existing addressing scheme.  It assumes only that you are giving your Appletalk nodes the same 
network number as your TCP/IP hosts, while assigning them to a different subnet.    

Another method for assigning IP addresses, called “fixed routing,” treats the Appletalk and Ethernet sides of the gateway as two separate networks; 
this is usually more difficult than subnetting.  

This guide explains how to assign IP addresses using the subnetting method only.  If you want to explore fixed routing, refer to the documentation 
that comes with your Kinetics FastPath.

Subnetting

The subnetting approach to assigning IP addresses on your network involves dividing your network into two logical subnets, one on the Ethernet side 
of the gateway and the other on the Appletalk side.  All of the stations on Ethertalk are assigned one subnet number and all the stations on Appletalk 
are assigned a different subnet number. 

The subnet number is derived by apportioning the IP address.  As explained above, an IP address has two parts — a network number and a local 
address.  In subnetting, the local address is further divided into a subnet number and a host number.  The subnet number is the same for all stations 
on a subnet; the host number is unique for each node or station on that subnet.

The routing code of the FastPath gateway directs data by grabbing packets whose destination subnet is different from its subnet of origin, performing 
protocol translation, and sending the packet across the gateway.

The FastPath gateway is assigned two IP addresses, one for the EtherTalk side of the gateway and one for the Appletalk side of the gateway.  With 
subnetting, each side of the gateway is on a different subnet, and has a different subnet number.  From the point of view of the TOPS Terminal 
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Macintoshes on Appletalk, the Ethernet subnet appears to be just another Appletalk network.  From the point of view of the TCP/IP hosts on 
Ethernet, the Appletalk network appears to be just another Ethernet subnet.  The FastPath gateway will view subnet numbers and AppleTalk network 
numbers as essentially the same thing.

Assigning IP Addresses

In many cases, when you add a gateway and Appletalk network to an existing Ethernet network, the Ethernet hosts already have IP addresses that 
had been previously assigned without consideration to subnetting.  This leaves an administrator with two choices.  One choice is to select a simple 
subnetting scheme and then reassign IP addresses to the Ethernet hosts in accordance with that scheme.

The other choice is to select a subnetting scheme which leaves the current IP addresses on Ethernet unchanged.  This may be easy to do, or it may 
require a complicated subnetting scheme.  In some cases it may not be possible.  The sections which follow describe the simplest subnetting 
schemes.  In most cases they will satisfy your subnetting needs.  For a more comprehensive treatment, you should refer to the documentation that 
comes with your Kinetics FastPath.  

As previously mentioned, in subnetting, the local address portion of the IP address is divided into subnet number and host number.  The number of 
bits selected for the subnet number is referred to as the “subnet size.”  The number of bits selected for the host number is referred to as the “subnet 
shift.”  

The selection of subnet size and subnet shift is somewhat arbitrary.  It will depend on which IP addressing scheme — Class A, B, or C — is being 
used on your Ethernet network, whether you are willing or able to reassign IP addresses to your Ethernet hosts, and on how many Appletalk nodes 
and gateways are on your network.  

The following examples illustrate the simplest Class A, B, and C subnetting schemes, starting with Class B.  

Example 1 - Class B Subnetting

The simplest case of subnetting is with Class B addresses.  If your Ethernet network uses Class B addressing, the first two bytes (16 bits) of an IP 
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address are the network number and the last two bytes (16 bits) are the local address.  

The easiest way to divide the local address portion into subnet number and host number is to assign one byte to each, so that both the subnet size and 
subnet shift are each 8 bits: 

131 131 131131 13232 1

Network Number

Local Address

Network Number

Subnet Number

 Host Number

Class B address Class B address 
with Subnetting

Suppose, for example that your existing Ethernet network contains a Sun Server with address 131.131.16.1 and a Sun Workstation with address 
131.131.16.2.  You are adding a FastPath and a TOPS Terminal Macintosh to this network.  Here are the class B addresses you might assign:

Class B Subnetting Address Table

131.131.16.1 Sun Server 
131.131.16.2 Sun Workstation
131.131.16.3 Ethernet side of Kinetics FastPath 
131.131.32.1 Appletalk side of Kinetics FastPath 
131.131.32.2 TOPS Terminal Macintosh

The first two bytes of the IP address are the network number, which is the same for all stations (131.131).  In this subnetting scheme, the third byte is 
the subnet number.  This number must be assigned differently for the Ethernet side and the Appletalk side of the gateway.  

Since the Ethernet stations in this example already had a subnet number of 16, the Ethernet side of the of the gateway was also assigned subnet 
number=16. The Appletalk side was arbitrarily assigned subnet number=32, to distinguish it as a separate subnet.

The fourth byte of the IP address is the host number and is assigned so that each station on a subnet has a unique number.   Here is a diagram of the 
above subnetting scheme:  
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Sun server Sun workstation 

Fastpath

Subnet Number = 16

Subnet Number = 32

131.131.16.1 131.131.16.2

LocalTalk side 

131.131.16.3
Ethernet side 

131.131.32.1

TOPS Terminal Macintosh 
131.131.32.2

The Ethernet side of the FastPath is on a subnet different from the Appletalk side (subnet 16 for Ethernet, and 32 for Appletalk).  Notice also that the 
Macintosh is on the same subnet as the Appletalk side of the FastPath (subnet number 32), just as the Sun stations are on the same subnet as the 
Ethernet side of the FastPath (subnet number 16).  The FastPath routes any packets originating from subnet 32 that are destined for subnet 16, and 
vice versa.

The selection of an 8-bit subnet size and 8-bit subnet shift in this example was chosen for the sake of convenience:  by so doing, the subnet number 
can be readily identified as the third byte of the IP address.  If the subnet size had been chosen as 10 bits and the subnet shift chosen as 6 bits, then 
the value of the subnet number would not be so evident.  You would have to calculate it by converting the IP address to its binary representation, 
looking at the first 10 bits in the local address portion and converting this 10-bit binary number back to its decimal equivalent.

Size and Performance Limitations:  
There are inherent limitations implied in the choice of eight bits for subnet shift and eight bits for subnet size:  an eight-bit subnet size allows for 256 
subnet numbers.  Since Appletalk does not allow a subnet net number of zero, the number of possible subnets is actually 255.  

An eight-bit subnet shift similarly limits the number of nodes in each subnet to 256.  The effect of our selection, then, is that at most you can have 
255 subnets with 256 nodes on each subnet.  Since AppleTalk itself 
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109 TOPS Terminal
limits the number of nodes per network to 254, the eight-bit subnet shift doesn't present any real limitation.

The performance of a FastPath that had anywhere near 254 nodes on the Appletalk side, however, would be severely degraded.  We recommend, in 
fact, that you restrict your physical configuration to no more than 16 nodes per Appletalk side of the FastPath.  This could possibly be exceeded in 
networks that are not very busy.

Example 2 - Class A Subnetting

Another relatively simple subnetting case is with Class A addresses.  If your Ethernet network uses Class A addressing, the first byte (8 bits) of an IP 
address is the network number and the last three bytes (24 bits) make up the local address. 

The simplest method of subnetting with Class A addresses is to divide the local address portion of the IP address so that the subnet size is 16 and the 
subnet shift is 8. 

89 2 32 1

Network Number

Host Number

2 3289 11

Network Number

Subnet Number

Subnet Host Number

Class A address Class A address 
with subnetting

Suppose, for example that your existing Ethernet network contains a Sun Server with address 89.2.32.1 and a Sun Workstation with address 
89.2.32.2.  You are adding a FastPath and a TOPS Terminal Macintosh to this network.  Here are the class A addresses you might assign:

Class A Subnetting Address Table

89.2.32.1 Sun Server 
89.2.32.2 Sun Workstation
89.2.32.3 Ethernet side of Kinetics FastPath 
89.1.56.1 Appletalk side of Kinetics FastPath 
89.1.56.2 TOPS Terminal Macintosh

The first byte of the IP address is the network number, which is the same for all stations (89).  In this subnetting scheme, the second and third bytes 
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together are the subnet number portion.  This portion must be assigned differently for the Ethernet side and the Appletalk side of the gateway.  

Since the Ethernet stations in this example already had subnet number portions of (2.32), the Ethernet side of the of the gateway was also assigned 
the same value. The Appletalk side was arbitrarily assigned subnet number portion (1.56), to distinguish it as a separate subnet.

The fourth byte of the IP address is the host number and is assigned so that each station on a subnet has a unique number.

What makes this Class A subnetting example more complicated than the Class B example is that the subnet number is not obvious by merely looking 
at the subnet number portion of the IP address. In the case above, with subnet number portion (2.32), the corresponding subnet number is 544. This is 
calculated by stringing together the binary representation of 2 (0000 0010) and 32 (0010 0000).  Binary 0000 0010 0010 0000 equals decimal 544. 
Similarly subnet number portion (1.56) corresponds to subnet number 184.

Note:  to avoid doing these calculations, use the GateWayName program described in the “How to set up the Kinetics Fastpath” in the next section of 
this guide.  If you enter the IP address in this program, it will calculate the subnet number directly.

Here is a diagram of the above subnetting scheme:  

Sun server Sun workstation 

Fastpath

Subnet Number = 544

Subnet Number = 184

89.2.32.1 89.2.32.2

Ethernet side 

LocalTalk side 

89.2.32.3

89.1.56.1

TOPS Terminal Macintosh 
89.1.56.2
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Class C Subnetting

The most complex case of subnetting is with Class C addressing.  Class C subnetting introduces a complication that doesn't enter with the Class A or 
Class B subnetting schemes described above. 

In a Class C address, only the fourth byte (eight bits) is available to represent both the subnet number and host number.  

16101191 29191 29 101 16

Network Number

Local Address

Network Number

Subnet Number

Host Number

Class C address Class C address 
with Subnetting

With Class C subnetting you cannot tell at a glance which IP addresses are in the same subnet.  Rather, it is necessary to use decimal/binary 
conversions to determine which subnet numbers and host numbers correspond to any local address portion of an IP address.  Since this is a bit 
involved, Class C subnetting tables are included for your convenience at the end of this appendix.  Using these tables, you can quickly assign IP 
addresses to different subnets without performing decimal/binary conversions.

Before using the tables, however, you must decide which subnet shift and subnet size combination you want to use.  A primary consideration in this 
decision is the number of Appletalk subnets you have in your network (that is, the number of FastPath gateways) and the number of nodes per 
subnet.

With Class C addresses, the combined subnet shift and subnet size is limited to eight bits (remember that the subnet size equals the number of bits for 
the subnet number and that the subnet shift equals the number of bits for the local address).  If you chose a subnet shift of three bits, this would allow 
for eight possible local addresss (decimal 0 to 7), or eight nodes.  The larger the subnet shift you define, the more nodes per subnet are available; 
with four bits, the limit is 16 (decimal 0 to 15).  For performance reasons, we recommend that you try to limit the number of nodes on the Appletalk 
side of the FastPath to 16.  
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Example 3 - Class C Addressing

In the following example, we will arbitrarily divide the available 8 bits into 4 for the subnet shift and 4 for the subnet size.  This happens to be a 
fairly good real world choice because it will allow 16 nodes per subnet and 15 subnets (Appletalk does not allow subnet net number 0).  

Suppose, for example that your existing Ethernet network contains a Sun Server with address 192.29.101.16 and a Sun Workstation with address 
192.29.101.17.  You are adding a FastPath and a TOPS Terminal Macintosh to this network.  Here are the class C addresses you might assign:

Class C Subnetting Address Table

192.29.101.16 Sun Server 
192.29.101.17 Sun Workstation
192.29.101.18 Ethernet side of Kinetics FastPath 
192.29.101.32 Appletalk side of Kinetics FastPath 
192.29.101.33 Macintosh with TOPS Terminal on Local Talk

If you look at Table 3 in the Class C subnetting tables at the end of this guide, you can see that the first three IP addresses (16, 17, 18) have subnet 
number 1 (which includes local addresss between 16 and 31) and the last two addresses (32, 33) were chosen to have subnet number 2.

The local address of the IP addresses jumped from 18 for the Ethernet side of the FastPath, to 32 for the Appletalk side because of the requirement 
that the FastPath's Appletalk and Ethernet sides must be in different subnets.  

Note:  You can also see from the tables that since subnet number zero is invalid, local addresss 0 to 15 are also invalid.  If your Ethernet stations had 
been previously assigned local addresss 0 to 15, you would have to change them in order to accomplish Class C subnetting.
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Here is a diagram of the above subnetting scheme:  

Sun server Sun workstation 

Fastpath

Subnet Number = 1

Subnet Number = 2

192.29.101.16 192.29.101.17

LocalTalk side 

Ethernet side 
192.29.101.18

192.29.101.32

TOPS Terminal Macintosh 
192.29.101.33

If you choose not to use the Class C subnetting tables, you could perform the decimal/binary conversion shown below: 

Station   Subnet #   Host # Host # IP Address 
Dec. Binary Dec. Binary Dec. Binary

Sun Server 1     (0001) 0  (0000) 16  (0001 0000)
Sun Workstation 1     (0001) 1  (0001) 17  (0001 0001)
Ethernet side FastPath 1     (0001) 1  (0001) 18  (0001 0001)
L-Talk side FastPath 2     (0010) 0  (0000) 32  (0010 0000)
Macintosh 2     (0010) 1  (0001) 33  (0010 0001)

Considerations using multiple FastPaths

With the FastPath, remember that all TCP/IP hosts that are to communicate through the FastPath with an Appletalk network must be in the same 
logical subnet as the Ethernet side of the FastPath.  If you are using multiple FastPaths to connect to an Ethernet backbone, you must configure all 
Ethernet sides of the FastPaths in the same logical subnet.

The Appletalk sides of each FastPath must have different subnet numbers as shown in the diagram below (for the case of Class C subnetting): 
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AppleTalk side 

192.29.101.48

Subnet Number = 1

Subnet Number = 3

Sun server 
192.29.101.16

TOPS Terminal Macintosh 
192.29.101.33

TOPS Terminal Macintosh 
192.29.101.49

FastPath 2

Ethernet side 
192.29.101.19

FastPath 1

Ethernet side 
192.29.101.18

Subnet Number = 2

AppleTalk side

192.29.101.32

Sun workstation 
192.29.101.17
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How to set up the Kinetics FastPath

Once you have decided upon a subnetting scheme (that is, chosen your subnet size and subnet shift) and assigned IP addresses to the Ethernet and 
AppleTalk sides of your Kinetics FastPath gateway, you are ready to configure your FastPath software.  This is accomplished using a program called 
the FastPath Manager, which is part of FastPath.  

Computing the Gateway Name

The first thing you will need to specify in the FastPath Manager program is a gateway name.  The gateway name is a hexadecimal string combining 
the AppleTalk side and Ethernet side FastPath addresses, preceded by a header specifying the subnet shift and subnet size in your subnetting scheme. 

If you are comfortable with decimal to hexadecimal conversions,  you can learn how to name your gateway by reading the Kinetics documentation.  
To make naming the gateway easier, we have provided a gateway naming program called GateWayName, included in the TOPS Terminal System 
Administrator folder.  Below is the screen from the program:  
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To calculate the gateway name, do the following:  

1. Type subnet shift and subnet size.

In  the Class A and Class B subnetting examples described in this guide, we recommended a subnet shift of eight and a subnet size of eight. 
In Class C subnetting they will vary.  If you are using Class C subnetting, refer to the previous section to determine the best choice of 
subnet shift and subnet size for your needs.

2. Type IP (internet) addresses.

Type the Internet addresses for the AppleTalk and Ethernet sides of the FastPath, respectively.  

3. Check subnet numbers

As you enter the IP addresses for the FastPath, the resulting subnet numbers for each side will automatically be displayed.  Check to make 
sure they are consistent with your subnetting scheme.  Remember that subnet numbers are equivalent to AppleTalk network numbers.  
When you run the Kinetics FastPath Manager (next section), you will need to supply these numbers, so make note of them.

4. Click Compute.

The gateway name will appear in the name field at the top of the screen.  When you quit GateWayName, the name (which is actually a 
number) will be copied to your Macintosh Clipboard, so you can paste it into the Kinetics FastPath Manager program.  Note this number if 
you are not going to be running FastPath Manager immediately.  

Using the FastPath Manager

The Kinetics FastPath Manager requires several inputs relating to the IP addressing scheme that you are using.  When completed, the configuration 
information in the FastPath Manager program is downloaded into the FastPath's static memory.  

1. Launch FastPath Manager.
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Double click on FastPath Manager.  The FastPath Manager configuration dialog window will be displayed:  

2. Enter Gateway Name.

Select the Gateway Name field and select Paste from the Edit menu  to enter the hexadecimal name calculated in the previous section.  

3. Enter LoadFile name.

The LoadFile is the packet-routing code that will run in the FastPath.  The name of the LoadFile you should use is “Etalkgw.srec.”  Select 
the Select LoadFile option from the File menu and choose “Etalkgw.srec.”  

4. Enter Zone Names (optional).

The zone is an AppleTalk concept, and is optional.  A zone is a logical partition of a network.  It is most useful in networks with many 
nodes, to reduce the network traffic in local work groups.  The zone names that you choose in this configuration are arbitrary.  If you give 
both the AppleTalk side and Ethernet side of the FastPath different zones names, you have created two zones.  The names must be 32 
characters or less (don't use asterisks or colons).  
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If you give both  sides the same name, both subnets will be part of the same zone.  You can also leave the default asterisks in the field for 
zone names, in which case you will use existing zone names, if there are any.  If no other bridge or gateway product exist on your network, 
there will be no zones.

5. Enter AppleTalk Net Numbers (subnet numbers) 

Since the FastPath routes packets from one subnet (Ethernet side) to another subnet (AppleTalk side), the FastPath configuration must 
specify the subnet numbers on both the AppleTalk and Ethernet sides of the FastPath.  These are the subnet numbers provided by the 
GateWayName program described in the previous section.

For example, in the Class B subnetting example in this guide, the Ethernet side of the FastPath has a subnet number of 16 while the 
AppleTalk side has a subnet number of 32.  

Type in the subnet numbers (be sure they do not conflict with other subnet numbers on your network):

6. Enter second half of the Ethernet address.
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The first part of the Ethernet address on the Ethernet side of the FastPath is already assigned by the manufacturer.  The second part of the 
address is chosen by you, however, and it must be different than any other FastPath on your internet.  For this reason, Kinetics recommends 
that you use the FastPath serial number.  

7. Save Configuration and Download to FastPath.

Once the dialog windows are completed, save the configuration by selecting Save Configuration in the File menu.  After saving the 
configuration, send it to the FastPath by clicking Send Config.  Then click Send Load  (the Etalkgw.srec routing code), and finally, click 
GO.

If the download goes all right and your addressing is correct, a diagnostic window will be displayed:  

Among other things, it will indicate “SUBNET routing is ON” if you did the FastPath configuration correctly.  Watch this window for a few minutes 
to make sure that no other messages appear.  Any IP addressing problems will return error messages.

If no error messages appear, click Stop and quit the program by choosing Quit in the File menu.

.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

Text Editing and Printing 120



.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

121 TOPS Terminal

D  ynamic Addressing with Kipper  

Once you have chosen your subnetting scheme and set up your Kinetics FastPath, you are ready to assign IP addresses to every station on your 
network.  Depending on your subnetting scheme you may need to reassign addresses on the Ethernet side of the network.  

When this has been done you are ready to assign addresses to the stations on the AppleTalk side of the network; this address assignment can be done 
statically, providing each Macintosh with a unique IP address.  

As an alternative to static IP addressing, TOPS Terminal comes with Kipper, a program which dynamically assigns IP addresses.  One Macintosh on 
the network is configured with a pool of valid IP addresses; other Macintoshes can then draw an address from this IP pool.  The Macintosh with this 
address pool becomes a dynamic address server to other TOPS Terminal Macintoshes and gateways on the network.  

Kipper is a database of addresses that a designated (non-dedicated) Macintosh can assign to the AppleTalk network.  You will probably want to leave 
the KIP Server running all of the time, and you will want to have a second machine on the network with the identical database (a file called Kipper 
memory, which resides in the System folder).  This machine would act as a backup KIP Server in case the first server developed mechanical 
problems.  See “Configuring and Installing Kipper” below for information about installing a KIP server and a backup.  

Note:  See the TOPS Terminal Help entries “KIP” and “AppleTalk TCP/IP” and related topics for more details about this subject.  

Should you use Kipper?  Kipper is a way to simplify address management, but it may or may not work in your situation; system administration 
may be difficult because of the possibility that users may be assigned different addresses each time they boot.  This would seem to be a small price to 
pay for the convenience Kipper provides.  
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Naming the KIP Server

The Macintosh that is the KIP Server must be given a name on the internet.  You do this through the TOPS TCP/IP module in the Control Panel.  

1. Copy TOPS TCP/IP to your system folder.

If you haven't already done so, copy TOPS TCP/IP from the TOPS Terminal floppy to the system folder of your hard disk or floppy.  

2. Select the Control Panel Desk Accessory. 

Select the Control Panel, which is one of the accessories listed in the Apple () menu at the top left of the Macintosh screen.  

The Control Panel will be displayed.  TOPS TCP/IP should be one of the entries.  (Resources are arranged alphabetically along the left side, 
so you may need to scroll downward to find TOPS TCP/IP.)  

3. Click on the TOPS TCP/IP icon.  

The Control Panel will display TOPS Terminal information.  

4. Click on the My Domain Name button.
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5. Type a domain name and click OK.

Type a domain name in the dialog window that appears and click OK.  Choose any name you wish.  

Now you are ready to configure and install Kipper.  

Configuring and Installing Kipper 

To configure and install Kipper, do the following:  

1. Copy Kipper to system folder of KIP server.
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Copy Kipper from the Administrator Folder of your TOPS Terminal disk into the system folder of the Macintosh that is to be the KIP server. 

2. Display the Control Panel.

3. Select the Kipper icon.

Click on the Kipper icon that appears on the left hand side.  

The Kipper address dialog will be displayed; it includes three address boxes for you to fill in:  Dynamic Ranges, Named Addresses, and 
Gateways:

4. Enter Dynamic Ranges.

Click New in the Dynamic Ranges box to begin entering ranges of IP addresses by subnet number; a dialog window like the following will 
be displayed:  
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Type a subnet number and the range of host numbers available for your networked Macintoshes on that subnet, depending on your 
subnetting approach.  The proper form for a subnet dynamic range is:  

[subnet number]: (m)-(n), . . ., (o)-(p)

That is, enter a subnet number followed by a colon and one or more ranges of host numbers, separated by commas.  A range can be one 
address long.  To allow all host numbers between 101 and 250 to be dynamically assigned on subnet 2, for example, type the following:  

After each subnet range of addresses is typed, click OK and then select New again for the next subnet range of addresses.  Be sure to include 
only those host numbers which are valid for your subnetting scheme.

Note:  You can let all user addresses be randomly assigned by Kipper, but if there are some user addresses that you do not want randomly 
assigned, do not include them in Kipper.  

Note 2:  Be sure that fixed addresses of hosts on the Ethernet side of the FastPath are not included in the dynamic ranges.  

5. Enter Named Addresses.  

Named Addresses include those for TCP/IP hosts, which cannot be dynamically assigned.  To input the loghosts, click New under the 
Named Addresses heading.  A good way to input those addresses is to associate the name with the address, as the diagram below shows.

Named addresses are a convenient way to address a host machine by a logical name (“sunhost” in this example) rather than an IP address 
(129.149.32.1).  When setting up an account description or making a manual connection, machines defined in this way can be referenced 
simply by their name.  
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6. Enter gateway addresses.

You also need to input the addresses on the AppleTalk side of any  gateways (such as the FastPath) on the network.  For this, click New 
under the heading Gateways.  

7. Click Authorized and reboot the Macintosh.

The last step is to click the button labeled Authorized at the bottom of the window and then reboot the Macintosh.  If you forget this step, 
the KIP Server will not work.  

Note:  it takes about five minutes after server reboot for all address resolution to be processed.  In general, you  need to leave the KIP 
Server running all the time.  

8. Create a backup KIP server.  

To be sure a KIP server is always available, create a backup server.  Repeat the steps in “Naming the KIP Server” (page 211) — but give the 
server a different domain name in step 5 — and repeat steps 1 to 7 in this procedure, “Configuring and Installing Kipper.”  
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You should be able to leave both servers running at once with no conflicts.  

Checking Kipper Status

Click in the “status” area of the Kipper dialog described above to see statistics about Kipper usage; a window will display KIP protocol statistics, 
including number of packets sent and received, error statistics, free addresses, and gateway requests.  
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Class C Subnetting Tables

How to use the Class C Subnetting Tables

1. Choose a subnet size and shift for your subnetting scheme.

Choose your subnet size and subnet shift, based on the number of subnets you require and the number of stations per subnet.  (For one 
FastPath, two subnets are required.  Each additional FastPath will require an additional subnet.)

2. Consult the subnetting tables.

Choose the appropriate table for your choice of subnet size and subnet shift.

3. Choose subnet numbers.

Choose a subnet number for the AppleTalk side of your FastPath and a different subnet number for the Ethernet side.  Under the subnet 
number in the table you will find the range of valid host numbers for that subnet.

4. Assign IP addresses.

For each node (or station) in a subnet, assign an IP address using the list of valid host numbers.  (Remember, in a Class C address, the first 
three bytes — the network number — are the same for every IP address on the network.  The host number is the fourth byte in the IP 
address.) 
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Table 1

2-bit subnet size (3 subnets)
6-bit subnet shift (64 nodes per subnet)

Subnet Number (1 - 3)
0       1        2        3  _   

IP 
Host # - 64 - 127 128 - 191 192 - 254
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Table 2

3-bit subnet size (7 subnets)
5-bit subnet shift (32 nodes per subnet)

Subnet Number (1 - 7)
    0     1      2     3___

IP 
Host #    - 32 - 63 64 - 95 96 - 127

    4      5      6      7___
IP 
Host # 128-159 160 - 191 192 - 223 224 - 255

Table 3

4-bit subnet size (15 subnets)
4-bit subnet shift (16 nodes per subnet)

Subnet Number (1 - 15)
    0     1      2     3 ___     

IP 
Host #    - 16 - 31 32 - 47 48 - 63

    4      5      6      7____
IP 
Host # 64 - 79 80 - 95 96 - 111 112 - 127

    8     9      10    11____     
IP 
Host # 128 - 143 144 - 159 160 - 175 176 - 191

    12      13      14      15___
IP 
Host # 192 - 207 208 - 223 224 - 239 240 - 255
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Table 4

5-bit subnet size (31 subnets)
3-bit subnet shift (8 nodes per subnet)

Subnet Number (1 - 31)
    0     1      2     3 ___     

IP 
Host #    -   8 - 15 16 - 23 24 - 31

    4      5      6      7____
IP 
Host # 32 - 39 40 - 47 48 - 55 56 - 63

    8      9     10     11____
IP 
Host # 64 - 71 72 - 79 80 - 87 88 - 95

   12     13     14     15
IP 
Host # 96 - 103 104 - 111 112 - 119 120 - 127

   16     17     18     19____
IP 
Host # 128 - 135 136 - 143 144 - 151 152 - 159

   20     21     22     23____
IP 
Host # 160 - 167 168 - 175 176 - 183 184 - 191

   24     25     26     27____
IP 
Host # 192 - 199 200 - 207 208 - 215 216 - 223

    28     29      30     31____
IP 
Host # 224 - 231 232 - 239 240 - 247 248 - 255
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Table 5

6-bit subnet size (63 subnets)
2-bit subnet shift (4 nodes per subnet)

Subnet Number (1 - 63)
    0     1      2     3 ___     

IP Host #    -   4 - 7  8 - 11 12 - 15

    4      5      6      7____
IP Host # 16 - 19 20 - 23 24 - 27 28 - 31

    8      9     10    11____
IP Host # 32 - 35 36 - 39 40 - 43 44 - 47

   12     13     14    15____
IP Host # 48 - 51 52 - 55 56 - 59 60 - 63

   16     17     18    19____
IP Host # 64 - 67 68 - 71 72 - 75 76 - 79

   20     21     22    23____
IP Host # 80 - 83 84 - 87 88 - 91 92 - 95

   24     25     26    27____
IP Host # 96 - 99 100 - 103 104 - 107 108 - 111

   28     29     30    31____
IP Host # 112 - 115 116 - 119 120 - 123 124 - 127

   32     33     34    35____
IP Host # 128 - 131 132 - 135 136 - 139 140 - 143

   36     37     38    39____
IP Host # 144 - 147 148 - 151 152 - 155 156 - 159

   40     41     42    43____
IP Host # 160 - 163 164 - 167 168 - 171 172 - 175

   44     45     46    47____
IP Host # 176 - 179 180 - 183 184 - 187 188 - 191

   48     49     50    51____
IP Host # 192 - 195 196 - 199 200 - 203 204 - 207

   52     53     54    55____
IP Host # 208 - 211 212 - 215 216 - 219 220 - 223

   56     57     58    59____
IP Host # 224 - 227 228 - 231 232 - 235 236 - 239
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    60     61      62    63____     

IP Host # 240 - 243 244 - 247 248 - 251 252 - 255
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Appendix

H
Troubleshooting

Network (TCP/IP) Connections

Listed below are error messages that you might see or problems that you might encounter in making a network connection.  

There's a Problem Starting TOPS TCP/IP

You may see the following message while booting-up your Macintosh:

Solution:  Try one of the following:  

• Click on “Try to find a KIP Server,” (only if you've got a KIP Server on your network, of course) and KIP will give you a default address. 
This generally works only if there is a bad connection somewhere in the network.
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135 TOPS Terminal
• Select “Configure TOPS TCP/IP By Hand,” and make sure that the addresses of your local gateway and the subnet shift and subnet size are 

set properly.  

• Select “Don’t Install TOPS TCP/IP.”  You then can only make a phone connection with a non-TCP/IP bulletin-board or remote service.  You 
will still be able to configure TCP/IP by hand in the Control Panel later, if you wish.

Cannot Connect to Computer By TCP/IP

The symptoms of this problem are that you give a "Terminal Session" command to call another computer, and the session transcript window is 
created normally, but the other computer never answers.  The session window status box (in the lower left hand corner) says "Connecting to 
[computer name]" until you close the window.

Solution:  The other computer may indeed not be answering:  it may be down or overloaded.  The problem may, however, be in your TCP/IP 
configuration or the intervening network.  Possible solutions in this case are:  

 • Check whether the host computer is down.

 • Verify that the cabling is secure and terminated (resistors at each end of the AppleTalk network) if you are using a TOPS TeleConnector, 
Farallon PhoneNET, or similar type of cabling.  One way to make sure your cabling is secure is to go to the Chooser to verify that you can 
see AppleTalk devices (such as an Apple LaserWriter) on the network.  

 • Check to make sure you have the correct IP address set up for your Macintosh in the Control Panel TCP/IP file (see page xiv in the Preface). 
Also check that the IP address of the remote computer is accurate in its computer description.  

 • Check your FastPath or other AppleTalk/Ethernet gateway to ensure that it is installed and configured correctly (and that the FastPath has 
version 3.0 ROMs).  Then make sure that the Ethernet subnet number and the AppleTalk subnet number are different from each other; in 
addition, both of these numbers must be different from zero (0) and unique in your internetwork.  We have included an application called 
“GateWayName” which aids in 
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136 TOPS Terminal
configuring the FastPath.  You may also refer to Appendix G (“System Administration Guide”) for more help.

 • Make sure that the Ethernet is connected and working properly.    A program,  “TOPS Peek,” available on our BBS (415-555-1212)   can 
help you diagnose the problem.  Consult the “readme” file   provided with TOPS Peek.

 • If you have a Hayes (or compatible) InterBridge on your   internetwork, confirm that it has 1.08 ROMs, and that it can be seen on the 
network with the InterBridge Manager.  Try   powering-off the InterBridge and restarting.

Note:  You cannot use two InterBridges and a FastPath daisy-  chained in series at this time.

 • Try a manual connection, typing in the IP address, to see if the connection works that way.  

AppleTalk Network # Does Not Match Subnet #

If you see this message, it’s an indication that the subnet number of your Macintosh's IP address is wrong.  The subnet number has to match the 
AppleTalk network number.  The Macintosh discovers its AppleTalk network number when it starts up; the AppleTalk network number is controlled 
by the bridges and gateways attached to the network.

Solution:  Pull down the Control Panel from the Apple menu, select TOPS TCP/IP, click on the button next to My Internet Address, and enter the 
correct IP address, Subnet Shift, and Subnet Size.  If an error still occurs, you need to check that each AppleTalk-Ethernet gateway is set up with 
matching subnet nubers and AppleTalk network numbers.  Be sure that all bridges and gateways agree on all network numbers.
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Socket Listener for IP Could Not Be Installed

This message might be displayed if there is a conflicting init file in the System folder of your Macintosh.  

Solution:  Try moving other inits out of the System folder.  If you experience this trouble on a Macintosh Plus, you may need to copy the AppleTalk 
file into your System folder.  A disk error when reading in the AppleTalk software could also bring up the message; copy a new System File and 
AppleTalk file (if any) from the TOPS Terminal disk to your Macintosh System folder.  You might also consider running Apple's Disk First Aid utility 
on the disk in question.

Gateway Address Not On Same Wire as the Mac

The network model of TCP/IP requires that each TCP/IP computer be on the same physical network as a TCP/IP gateway.  Two TCP/IP addresses are 
on the same physical network if they match in both network and subnet numbers.  Therefore, the Macintosh TCP/IP address and the gateway TCP/IP 
address must match in both network and subnet numbers.  You will see this message if these numbers do not match.  

Solution:  If you get this message after configuring TCP/IP in the Control Panel, go back to the configuration dialog and make sure the network and 
subnet numbers of the two TCP/IP addresses match.

The AppleTalk (.MPP) Driver Cannot Be Opened

A corrupted System file can cause this error message to be displayed.  

Solution:  Run the Installer on Apple’s System Tools disk (Utilities folder).  If the problem still occurs, you need to copy over a new System file to 
your Macintosh System folder.  Again, Apple's Disk First Aid utility might help.

TOPS TCP/IP Can’t Get Enough Resources to Connect

You might see this message if there are too many sessions going at once on a Macintosh with limited memory.  You may also see this message if the 
maximum number of network connections under preferences is set too high.  
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138 TOPS Terminal
Solution:  In addition to reducing the TCP buffer size (in the Control Panel) and rebooting, as the message suggests, try reducing the number of 
concurrent sessions.

Trying to connect, network accounts not enabled

If network accounts are “grayed out,” indicating that they cannot be used, TOPS Terminal cannot find a valid TCP/IP address for your Macintosh.  

Solution:  You may have to enter a TCP/IP address (as explained in the Preface, starting on page xii), or you may need to reboot your Macintosh.  

Phone Connections

Listed below are error messages that you might see or problems that you might encounter in making a phone connection.  

Trying to connect, phone accounts not enabled

If modem accounts are not enabled, there are three likely problems:

•  You have not designated a modem type  
•  The modem is in use for another connection
•  You are trying a phone connection during a file session

Solutions:  Select a modem type (see Appendix B for details), close the other connection, or select Terminal Session for phone connections.  

Phone account - don't get CONNECT response

If nothing happens after you click Connect when making a phone connection, the modem speed may be wrong.  

Solution:  Select Send Break in the Controls submenu of the Network menu to drop the baud rate of the remote computer's modem down one step 
(from 2400 to 1200 baud, for instance) and press Return.  If that doesn't work, you may have to hange the baud rate in the Description of an Account. 
You will have to close the connection first and try the connection again after you have changed the baud rate.  
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139 TOPS Terminal

Phone account - no response after CONNECT

If you reach the remote computer successfully and see the response “CONNECT” (or a similar response), but you can't do anything, your modem 
settings may be wrong.  Some connections require two carriage returns, some require a Control-C, for example.  These settings are set in the 
attention line in the description of a computer.  

Solution:  Check with the system administrator on the remote computer to find out what you need to do, and what settings are necessary.  

General Troubleshooting

Listed below are general problems you might encounter or error messages that might be displayed for either network or phone connections.  

Using TOPS Terminal with MultiFinder

TOPS Terminal works fine under MultiFinder; however, there are some limitations you should be aware of. If you limit TOPS Terminal to 350K or 
less in the Get Info window, the following problems may occur:

•  Large text files may fail to open.
•  An out of memory error message may come up on screen.
•  You may need to save smaller amounts of data in a session
    transcript.
•  TOPS Terminal might disconnect your current session.
•  TOPS Terminal may crash.  

Solution:  Set TOPS Terminal to 350K or larger under MultiFinder.

If TOPS Terminal crashes, select the resume button, which will be highlighted in most circumstances.  If you use Macsbug 5.4 or later, you can type 
“es” in order to exit to the Finder.

Trying to connect to KIP Server

If there are two Kippers on the network and one assigns an IP address already in use (due to overlapping address ranges in the databases on the two 
Kippers), this message will appear.  
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140 TOPS Terminal
Solution:  To prevent the problem, configure the two Kippers so that there is no overlap of IP addresses.  If the problem occurs, which is not very 
likely even with overlapping addresses in the databases of the two Kippers,  reboot your Macintosh; another IP address will be found.  

Unable to create TOPS Terminal Memory file

If this message appears, your TOPS Terminal Memory may be corrupted, there may be a disk error, or you may be running two separate copies of 
TOPS Terminal under MultiFinder.

Solution:  Discard the TOPS Terminal Memory file in your System Folder, replace it with a backup copy, and reboot your Macintosh.  If you don't 
have a usable backup copy, create a new one after discarding the old one; a new TOPS Terminal Memory is created when you quit TOPS Terminal 
after starting up TOPS Terminal and creating a new description.  

Trying to connect, automatic account; no response

There are a number of reasons that this might happen, including an incorrect IP address for the remote computer, an incorrect user name,  or an 
incorrect password.  

Solution:  Be sure the remote computer is up and that it is enabled for logins.

Also check the computer description to be sure you have specified the appropriate operating system (UNIX is the default for new computer 
descriptions).  

Try a manual connection to the computer, typing in the IP address when it is requested.  See Chapter 2 for a description of manual connections.

Check the FastPath Manager setup (or ask your system administrator to check it).

Invalid login message when trying to connect

Check your user name for misspellings, extra spaces, incorrect capitalization, or extraneous characters.  
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Solution:  Re-enter your password by checking the Password saved in TT Memory box in the account description and following the instructions 
provided.  You will have to check the box twice — once to 'uncheck' it and the second time to tell TOPS Terminal that you want to enter a password 
for the account.  Click OK when you have entered the new password.  

If the connection doesn't work after you have checked and modified your user name and password, try a manual connection, as described in Chapter 
2.  

If it still doesn't work, check with the system administrator on the remote computer to be sure your user name and password are set up as you think 
they are.  

Established connection - stops responding

If you were working on a remote computer in a terminal session and the computer stops responding, the connection to the remote computer has 
probably been broken.  This may happen because the remote computer was disconnected from the network, was rebooted, or went down.  This could 
also happen because of a network or modem problem.  

The status box at the lower left will change from “Connected to [computer name” to “Editor Document,” but no error or kill connection message will 
be displayed.  

Solution:  Try to make another connection by selecting the same account after selecting Terminal Session in the Network menu.  (This won't work if 
the remote computer or the network is down, of course.)  Save the transcript if you wish.  

Screen displays meaningless characters

This can happen if you try to display the contents of a non-ASCII file during a terminal session.  

Solution:  To clean up the screen, select Reset Terminal from the Network menu.  If Reset Terminal is not available in the Network menu, display the 
full menu by following the instructions in Appendix B.  It may be necessary to press Return if you are in a shell to get the prompt again.  If you are 
in an editor, you will have to select the editor's redraw screen command to get the prompt again.  
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Script stuck in a loop

If no question in a script is matched, it may get stuck in a loop.

Solution:  Terminate the script with the interrupt command, ⌘ -. (Clover-period).

Running out of memory

A session transcript is kept in memory during a TOPS Terminal session, unless you select Don't Capture  Lines Off Top in the account description or 
you toggle Capture  Lines Off Top to the off position (no check mark) during a session.  If your Macintosh runs out of memory, a dialog window 
with several options will be displayed.  

Solution:  Follow the instructions in the dialog window.  Click on Capture  Lines Off Top to free up the memory used to store the transcript; save the 
transcript before you do this (if you wish).  

UNIX users - User name or password invalid

If your user name is all lower-case letters in the UNIX password file, it will not be recognized if you type it with initial caps.  UNIX operating 
systems are case-sensitive, meaning that upper-case letters are not the same as lower-case letters in file or directory names — nor in the password 
file, where your user name and password are stored.  

Solution:  Type your user name and password in a TOPS Terminal account description exactly as it entered in the password file on the UNIX 
system.  

UNIX users - “No such file or directory” message

If you try to send a file with slashes (/) in its name to a UNIX computer, the file will not be saved and you will see the message “No such file or 
directory.”  (This happens because slashes are used to designate directories in the UNIX hierarchical file system.)  

Solution:  Change the name of the file before trying to send it to the UNIX computer; substitute hyphens for slashes in dates, for example.  
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UNIX users - flashing screen when invoke vi editor

This indicates that the UNIX stty is set to 34 rows, 80 columns (9400 baud).  Type “stty all” to check the row and column settings.

Solution:  Reset the rows to 24.  

VAX users - screen problems with VT100 setup

If you have told TOPS Terminal to emulate a VT100, but the characters on the screen do not look right, you may be missing a line in a file.  

Solution:  Be sure you have the following line in your login.com file on the VAX: set term/inquire
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Glossary

Some of the terminology employed in the manual may be unfamiliar to you, especially if you are new to network communications or 
telecommunications.  We have collected the most important of these terms into the following list for handy reference purposes.  You may also obtain 
useful information and hints by selecting the TOPS Terminal Help selection under the Apple menu, or by clicking Help in many of the dialog 
windows.

Account Description
The information which TOPS Terminal uses to make an automatic connection to a remote computer.  The account description includes the name of 
the remote computer and information about your login ID on the computer.  

AppleTalk Personal Network
A collection of computers and peripherals linked together (using LocalTalk, PhoneNET, TOPS Teleconnector, or another compatible network cable 
system), allowing communication, file transfer, and document printing.  Your AppleTalk network must be connected to Ethernet using an 
AppleTalk/Ethernet gateway in order for TOPS Terminal to be able to access remote computers on Ethernet.  You can also connect most Macintoshes 
directly to Ethernet by adding Ethernet hardware.  

Automatic Connection
The process by which a communications software package (such as TOPS Terminal) automatically connects and logs on to one computer from 
another computer — either on a network or through a modem over a phone line.  TOPS Terminal accomplishes this by invoking built-in scripts 
which are linked to a particular remote computer through an account description.  

Baud Rate
The speed at which two computing devices communicate with each other.  For modems, 1200 baud (or bits per second) is the standard 
communication 
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145 TOPS Terminal
speed, although 300 baud is still common and 2400 baud is becoming  increasingly available.  For direct connections between a terminal and a 
computer, 9600 baud is very common.  

Command Line
The standard user interface on some computer systems such as MS-DOS or UNIX.  The computer will issue a “prompt” character (such as “%”) 
indicating that it is ready to accept user commands; the user then issues a command line.  The Macintosh generally avoids the need for command 
lines by using dialog windows, a mouse, and menus.  

Ethernet
A collection of computers and peripherals linked together using Ethernet network cables, usually communicating with one another using the TCP/IP 
protocol suite.  An Ethernet network can be linked with an AppleTalk Personal Network using an AppleTalk/Ethernet gateway (such as the Kinetics 
FastPath).  

File Session
A session on a remote computer for the purpose of copying files to or from that computer and your Macintosh.  file session is started when you log 
on to a remote computer after selecting File Session in the Network menu.  

File Transfer
The process of copying a file from one computer to another.  File transfer may occur over network cables or over phone lines.  

FTP
Stands for ‘File Transfer Protocol’.  FTP is a part of the TCP/IP protocol suite which allows file transfer between disparate computers.  

Gateway
Any hardware device that connects two physically distinct networks, whether they are of the same kind (such as two Ethernets) or of different 
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kinds (such as an AppleTalk network and an Ethernet network).  The Kinetics FastPath is an AppleTalk/Ethernet gateway.  

Internet
A collection of networks, all of which contain computers using the TCP/IP network protocols, hooked together by TCP/IP gateway hardware.  

IP Address
A unique (Internet Protocol) address which specifies both the address of a network on an internet and the address of a particular station on that 
network.  

KIP
A protocol for dynamically assigning IP addresses to your TOPS Terminal Macintoshes.  Addresses are assigned when a Macintosh is started up.  

LocalTalk
A physical network, including connectors and cables, that implements AppleTalk network protocols.  TOPS Teleconnector and PhoneNET are other 
compatible systems.  

Log in (or log on)
To connect and gain access to a computer system.  For most multi-user systems, the login process involves giving a user name and a password.  

Log out (or log off)
To disconnect from a computer system.  

Macro
A kind of computer program that executes a sequence of operations during terminal or file sessions.  A macro has the same format and syntax as a 
script, but it is executed when you select it explicitly from the list of macros available.  

Modem
A device that allows two computers (or a terminal and a computer) to communicate over normal telephone lines.  “Modem” stands for 
“modulator/demodulator.”  

Network
A group of computers, printers, terminals, file servers, and other devices 
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147 TOPS Terminal
connected to each other by means of hardware and software that allows the various computers and devices to communicate with each other.  

Operating System
An operating system is the “program” that manages the resources of a computer (memory, central processor, peripheral devices, etc.) and allows it to 
run other programs.  The operating system of a computer also determines how you interface with the computer — how you log in and log out, 
execute programs, list files and directories, and copy or delete files, for example.  

Operating System Description
The way operating systems are described in TOPS Terminal.  The built-in operating system descriptions that TOPS Terminal knows about are UNIX, 
VMS, Red Ryder Host, and FidoNet.  

PhoneNET
A physical network, including connectors and cables, that implements AppleTalk network protocols.  TOPS Teleconnector and LocalTalk are other 
compatible systems.  

Protocol
A set of rules ensuring that data communication takes place reliably and without error.  TOPS Terminal uses TCP/IP protocols for network 
communication and the XMODEM protocols for phone communication.  .  

Remote Computer
A remote computer is any computer that you log on to from your Macintosh using TOPS Terminal — using either network or phone connections.  

Script
A kind of computer program that is executed when you select functions in the Network menu.  For example, when you start a terminal session and 
choose an account to connect to a remote computer, TOPS Terminal calls a “built-in” login script that identifies you to the computer.  Other scripts 
perform functions such as copying files from your Macintosh to a remote computer, listing files on a remote computer, and logging off from a 
remote computer.  

Service
A set of functions or operations that can be performed on a remote computer using TOPS Terminal menus.  Services are grouped into terminal 
session 
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148 TOPS Terminal
and file transfer services, and are provided by TOPS Terminal through scripts.  

TCP/IP
A protocol suite allowing error-free communication over an arbitrary network.  TCP/IP is an abbreviation for ‘Transmission Control 
Protocol/Internet Protocol’.  This set of protocols is more properly called “the Internet Protocol Suite,” but is commonly named TCP/IP since TCP 
and IP are the two main protocols used by Internet network services.  

TELNET
A protocol which is built on top of TCP/IP and is used for managing terminal sessions over a network.  

Terminal
A device for communicating with a computer.  Typically, a terminal is just a screen and a keyboard that is directly connected to the computer through 
a serial cable or remotely through a modem.  

Terminal Emulation
The process whereby a computer such a Macintosh can “pretend” to be a specific type of terminal and carry on an interactive terminal session with a 
remote computer.  TOPS Terminal allows the Macintosh to emulate a generic “dumb” terminal, a VT52, a VT100, a VT102, and an adm3a.  

Terminal Session
A session on a remote computer for the purpose of using your Macintosh in terminal emulation mode.  A terminal session is started when you log on 
to a remote computer after selecting Terminal Session in the Network menu.  
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149 TOPS Terminal
TOPS Teleconnector
A physical network, including connectors and cables, that implements AppleTalk network protocols.  LocalTalk and PhoneNET are other compatible 
systems.  

User Interface
The way that a computer “looks” and “feels” as you interact with it.  On the Macintosh, operations are usually performed within windows using the 
mouse to select text or commands from menus.  On more traditional operating systems, the typical user interface is command-line oriented, although 
recent improvements to some of these systems incorporate many of the Macintosh features.  

XMODEM
A file-transfer protocol designed for modem communication.  TOPS Terminal automatically uses the XMODEM protocol when transferring files 
over a modem.  
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Index

A
about this manual xvi
about TOPS Terminal xxiii
account description 5, 33, 44, 229

computer from sign-up file 49, 
  138
computer from TT Memory 44,
  138
new computer description 52,
  138
modify 68, 138
remove 73, 138

account, network & phone 5
active window 7
address

dynamic, with Kipper 210
gateway xiii, 197
internet 196
IP, with gateway 197
Macintosh xi-xv
network computer 21
static vs. dynamic 197

adm3a xxv
All topics button, Help xxi
answer syntax 91
append transcript to file 62
AppleLink xxi
AppleTalk ix, 195-205, 229
ARPANET xv, 5
arrow keys 14
auto-dial xxvi
automatic connection xxvi, 5, 33-

74, 138, 229
create account description 44
create computer description 35
making an 56
overview 34

B
Back button, Help xx
background window 7
backup

KIP server 216
master disk x

basic 
concepts 4
terminal session functions 75
TOPS Terminal functions xxv

baud rate 28, 42, 135, 229
BBS 29
before you begin ix
BIX xxi
built-in 

commands (scripts/macros) 174
operating system descriptions 

     185
service descriptions 182

button press equivalents 87

C
Capture  Lines Off Top 84-85
carriage return, in operating system

description 180
character set 149
class A subnetting 201
class B subnetting 199
class C 

subnetting 202
tables 217-20

Clear Lines Off Top 83

.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

Text Editing and Printing 150



.page. newpath
72 144 moveto 0 9 rlineto 0 -9 rmoveto 9 0 rlineto
72 756 moveto 0 -9 rlineto 0 9 rmoveto 9 0 rlineto
468 144 moveto 0 9 rlineto 0 -9 rmoveto -9 0 rlineto
468  756 moveto 0 -9 rlineto 0 9 rmoveto -9 0 rlineto
stroke

151 TOPS Terminal
close connection 90
Clover ( ) ⌘ key 43, 85, 135, 150
command line 136, 229
Commands menu  75, 136

180
communication protocols xxviii
CompuServe xxi, 165, 183, 186
computer description 33-44, 137

create 35
    from TT Memory 44
    from sign-up file 49
modify 65
network connection 35, 137
phone connection 38, 42, 137
remove 67

computer vs. terminal xxiv
connection, automatic 33, 74
Control key 11, 62, 80-82, 136, 

in operating system description
    184
none on keyboard 80
simulate 82
Your Preferences 150

Control Panel xiv-xv, 
TCP/IP xiv

Controls menu 44, 75, 80-82, 136
Copy File command 77
copy and paste 87
copy

files 93-110
master disk x

create description
account 44-56
computer 35-44
    network connection 35
    phone connection 38
modem 154
operating system 185
service 182

D
data format 95
datagram xxviii
debug command 169
default button 14, 15
Delete File 77
Delete key 180, 186
description 

account 44-56
  computer from TT Memory 44
  computer from sign-up file 49   describe new computer 52

computer 35-44
  network connection 35
  phone connection 38
modem 154
operating system 185
service 182

desktop computers xxiv
dial 9 for outside line 39
dialog window 13
disconnecting 85, 89
domain name xv, 212
Don't Capture Lines Off Top 71
Don't Save Session Transcripts 58,

60, 72
double click 15
dynamic addressing with Kipper
     210

E
ed editor 19
Edit File 

network account 122
phone account 127

Edit menu 10, 23, 85, 114
editing xxv, 19, 111-128

during terminal session 87
existing editor document 120
script or macro 173
sign-up file 192
tools 112
with TOPS 128

editor document 8
transcript becomes 88

editor on remote computer 127
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Erase Line 82
Erase Word 82
error-correction xxviii
escape key

none on keyboard 80, 150
simulate 82, 150
TOPS BBS 30-31
Your Preferences 150

Ethernet ix, xxviii, 195-207, 230

F
FastPath ix, 195-215

Manager 207
set up 207

File Info 79
File menu 9, 20, 85, 112

Delete 22
Print Document 129
Print Many 130
Print Selection 130
Revert to Saved 113
Save Selection 114

file 
handling 20
naming 8, 95
session 6, 56, 138, 230
session window 57

file transfer xxv, 6, 93-110, 139, 
230
formats 94
network 96
phone 106
protocols xxix
service 184
UNIX 95

find 115
and replace 117
wraparound 142

Flush Output 81
format 

data 95
file transfer 94
MacBinary 94
scripts and macros 161
text 94

FTP xxix, 4, 6, 8, 57, 136, 230
full menus 143

Network 145
Settings 146

G
gateway ix, xiii, 195-209, 230
GateWayName program 206
getting started 1
Go To 78
Goodbye 80

H
hardware requrirements ix
Help xix

All topics xxi
buttons xix
installation x
telephone xxi

hierarchy of descriptions 176

I
installation

Help x
Kipper 211
TCP/IP x
TOPS Terminal software x

internet address 194, 230
interrupt 83
introduction, TOPS Terminal xxiii
IP address xii-xv, 195-205, 230

J
Jump to 

Insertion 115
Selection 115

K
keyboard 

button presses 15
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equivalents 135
or mouse 13
shortcuts xxvii, 86, 135

kill connection 85
Kinetics FastPath ix, xxviii, 205
KIP server xii, 210, 230

backup 216
naming 211

Kipper x, xi, 36, 127, 129
installing 213

L
List Files 77
Literal 82
local 

copy on edit 147
echo 185
editing 118, 140

LocalTalk 230
log in 176, 179, 230
log off 89, 230
lower case 17

M
MacBinary format 94
Mac shortcuts 86
macro 85, 159-74, 231

example 166
executing 169

making an automatic connection 56
Manual Phone 24
manual connection 

network 19, 137
phone 24, 137

master disks, copying x
maximum number of sessions 147
memory, running out of 227
menus 9, 135

edit 10
file 9, 20, 85
network 10
settings 11
text 12
windows 12

modem ix, 5, 24, 28, 39, 137, 152
    231
description, 
    creating new 154
    modifying 156
description, removing 157

problems 224
selecting type 153
settings 42
speaker 39
type 25, 39, 153

modifying descriptions
account 68, 138
computer 65, 137
modem 156
operating system 187
service 185

monitoring terminal sessions 151
Move File 78
MultiFinder xxvii, 225
multiple choices in list 16
multiple windows 7
multitasking xxvii

N
name

file 8, 95
KIP Server 211

Network menu 10, 136
Clear Lines Off Top 83
Commands 76
Controls 80
Edit File 122
full 143
Interrupt 83
Pick Macro 85
Receive File 101, 108
Reset Terminal 85
Send File 96, 106
Send Text 82

Next button, Help xx
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null-modem cable ix

O
on-line help xix
operating system description 231

create 185
modify 187
independence xxvi, 231
remove 187

P
packet-switching network xxviii
password 46, 68, 79, 148

changing 69
security 68

phone account
file transfers 106
Receive File 108
Send File 106

phone connection
trouble shooting 29, 224

Pick Macro 85, 169
power keys xxvii, 87, 135
preferences 141
Print 

button, Help xxi
Document 129, 140
Many 130, 140
Selection 129, 140

printing xxv, 128-34
from the Desktop 133
font 143

protocols xxviii, 231
TCP/IP xxviii
XMODEM xxix

pulse dialing 39

Q
question syntax 162-63
Quick Reference Guide 135
Quit button, Help xxi
quitting TOPS Terminal 3

R
Receive File, 

network 101, 139
phone account 108, 139

remember passwords 148
remote computer xxv, 33, 231

remote editing xxvi, 122-27, 140
removing descriptions

account 73
computer 67, 137
modem 157
operating system 187
service 185

replace 117
requirements, hardware ix
Reset Terminal 85
Revert to Saved 113

S
Save Selection 114
saving 

editor document 112
session transcript 8, 58, 72, 88

scripts and macros xxvii, 159-74, 
    231
built-in commands 174
script example 164

search (see find)
Select All 87
select and click 15
selecting 

from a list 16
modem type 153
text 112

Send Break 82
Send File command 

network account 96, 139
phone account 106, 139

Send Text 82
service description 182-85, 232

create 182 
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modify 185
remove 185

session 
maximum number 147
transcript, saving to disk 88
window 6, 7

Settings menu 11, 146
shortcuts 86
sign-up file 49, 189
startup 1
static vs. dynamic addressing 197
subdomain xv
subnet shift and size xii, 198
subnetting 198

Class A 201
Class B 199
Class C 203
Class C tables 217

summary instructions 137-40
syntax, scripts and macros 162

T
tab key 13
tables, class C address 217-20
TCP/IP xxviii, 232

installation x
Timeout 37

technical support xxi
telephone help xxi
TELNET xxix, 232
temporary folder 149
terminal xxiii, 232

emulation xxv, 75-92
service 75, 83
session 11, 57-64, 71, 75, 138
    editing 87
type 21, 28, 48, 73

testing scripts and macros 169-73
text 

editing 111-33, 140
transfer format 94
wrapping 152

Text menu 12
text wrapping 152
Top button, Help xxi
TOPS BBS xxi, 29, 30
TOPS network xxx
TOPS Terminal 

basic functions xxv
features xxvi
Help x

introduction xxiii
Memory xxvi, 6, 46
overview xxiii-xxx

transcript xxvi 
becomes editor document 88
name 26
append to file 62
saving 8, 58

transfers, file 93-110
trouble shooting 221-28
Type File 79

U
UNIX file names 8, 95
upper case 17

V
VMS 

Delete key 186
file names 8, 95

W
windows xxvii, 6

active 7
changing 6
dialog 13
moving 6
multiple 7
sizing 7

Windows menu 12
writing scripts or macros 159

X
XMODEM xxviii, xxix, 233
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Y
Your Preferences 141

Z
Zap Program 82
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